
The FLUX HEXA is our newest generation flagship 
machine that brings together our years of experience 
in laser technology. We know that good maintenance 
will keep your machine in top condition for years 
to come. In this manual, you will learn how to use 
your HEXA, and how to make the most of the laser 
processing characterist ics of various materials . 
If you have any questions about the operation of 
your machine, please feel free to contact us via our 
website. Finally, we would like to thank our customers, 
partners, and friends again for your trust as we 
continue to strive to bring you the very best user 
experience.

Cheers,

FLUX Team

THANK YOU FOR CHOOSING FLUX,
IT IS A GREAT HONOR FOR OUR TEAM.



CH1
005

006

026 100

068

008

030 102

090

0 1 4

0 1 8

034

046

048

058

094

Before Getting Started

1-1 Labels

1-2 Safety Precautions

1-3 Product Specifications

1-4 Laser Engraving Principle

CH3
067Software Operation

3-1 Software Interface

3-2 Four Creation Techniques

3-3 File Formats

CH4
099Material Tips

4-1 New Materials Testing

4-2 Material Characteristics

CH2
025Start

2-1 Unboxing

2-4 Software Installation 
      and Activation

2-2 Assembly and Setup

2-5 Connection Settings

2-3 Machine Interface

2-6 Beam Studio Tutorial

CONTENTS

002



1 82

232

236

246

122

1 84

208

210

224

242

124

130

160

CH5

CH8

121

228

Maintenance

Disclaimer

5-1 Maintenance

5-2 Panel

5-3 Working Area

5-4 Back Cover

CH6

Appendix 1

Appendix 2

Appendix 3

181

231

235

245

Troubleshooting

6-1 Troubleshooting

Appendix 1-1 
Add-on Introduction

Appendix 2-1 

Design Software 
Recommendations

Appendix 3-1 
Maintenance Checklist

6-2 Hardware Issues

6-3 Software Issues

6-4 Comprehensive Issues

6-5 Contact Customer Service

Appendix 2-2 
Design Inspiration

Help Center

CONTENTS

CH7
226Warranty

003





Before
 Getting
 Started

CH 1



CH 1-1
Labels

The HEXA has 6 labels in total. Warning labels 
describe potential risks. Please familiarize 
yourself with all safety guidelines before use.



CH 1-1 Labels

1. Product label 2. Laser light warning label

3. Fire hazard warning label

On the bottom right corner of the back 
of the machine

On the right side of the first reflective 
mirror outlet (circle outlet)

please avoid eye or skin exposure to 
laser beam.

please do not operate machine 
unattended

On the left and back side of the 
machine

Below the screen

Below the screen
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CH 1-2
Safety
Precautions

Please read the following safety precautions 
carefully before operating the HEXA. Since the 
HEXA generates a high-power laser, improper 
operation may result in fire, visual impairment, 
skin burns, inhalation of toxic substances, and 
other harmful or adverse health effects to per-
son or property.



Do not leave the HEXA operating unattended. Press pause if you need to step away.

Do not stare at the light produced by the 
laser while the machine is cutting and 
engraving.
 

Please confirm the material to be engraved 
will be safe to burn at high temperatures.

Always have an accessible, functioning fire 
extinguisher in the work space.

Do not disassemble the HEXA without prior 
authorization from FLUX.

CH 1-2 Safety Precautions

Please consult FLUX regarding any usage or safety concerns.
support@flux3dp.com / (+886) 2651-3171
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Operators

Confirm that users intending to operate the machine have read all safety 
precautions carefully and will follow the instructions in the manual.

DO NOT let minors operate the HEXA alone.

Working Environment

˙Place the machine on a level, stable surface, ensuring there is no overhang 
or tilt.

˙Place the machine in a well-ventilated indoor space with windows. Do not 
place the machine outdoors, in the basement, under a metal roof, or in other 
confined spaces.

˙Set the open end of the HEXA’s vent hose outside of a window.
˙In case of rain or extreme weather, please stop using the machine and put 

the vent hose away indoors. Do not expose the machine to high humidity, 
splashing rain, or  direct sunlight.

˙Stored the machine at an ambient temperature between 5°C and 40°C and
 humidity between 10% and 70%.

˙The HEXA should be operated at an ambient temperature between 5°C and
25°C (if the power is below 40%, the ambient temperature may be be relaxed 
to  as high as 30°C).

˙DO NOT place any liquids or flammables near the machine.
˙DO NOT let children play near the machine.
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Safety Switch

˙Lifting the door cover should trigger the safety switch to suspend the 
operation of the machine and stop the output of the laser. If the machine 
fails to suspend operation after the cover is lifted, please stop using the 
machine, turn off the power, and contact customer service immediately.

˙For your safety, do not put your  hands, eyes, or other parts of your body
 near the operating area of the laser.

˙When adjusting the optical path, please make sure to close the door cover 
before testing to prevent injury in case the safety switch fails.

˙DO NOT operate the machine in case of safety switch failure.
˙DO NOT try to disable the safety switch. 

˙Verify that the model you received is the correct voltage (110V or 220V).
˙Ensure that the 3rd prong of the socket is grounded. An ungrounded circuit

may cause static interference, affect performance, or increase the risk of 
electric shock.

˙If the power cord is damaged, stop using the machine  immediately.
˙Always turn off the power and disconnect the plug before cleaning. Do not
   try to service or disassemble the machine without authorization from FLUX.

Power and Wires

DO NOT bend, twist, pull, or put heavy objects on the cables or plugs. 
Keep cables and plus away from heat sources.

CH 1-2 Safety Precautions
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˙Regularly clean the debris under the honeycomb table of the machine.
˙In case of fire, turn off the power immediately and unplug the power cord.

Use a wet towel to extinguish the fire. Note: water may irreversible damage 
the machine.

˙If the fire is relatively large, use a fire extinguisher. Note: the dry powder
or foam from the fire extinguisher may cause irreversible  damage to the 
machine.

˙If the fire spreads, please call the fire department immediately for assis-
tance.

Fire Risk

˙Please see “Material Tips - Hazardous Materials (p.111)” for a list of materials
that are not suitable for lasers processing and for more information.

˙DO NOT try to cut multiple boards at once by stacking materials in the
machine.

˙DO NOT operate the machine unattended.

˙Set the open end of the HEXA’s vent hose outside of a window or connect
 to an air purifier.

˙If you detect strong odor or heavy smoke, please stop using the machine.
Make sure the vent hose is properly connected and the ventilation system 
is working properly before use.

Ventilation
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Additional Operation Notes

˙DO NOT stare at the light produced by the laser during operation.
˙Strong vibrations may cause the optical path to shift or the laser tube

 to be damaged.

˙Have two or more people move the machine to  avoid injury.
˙Wearing gloves while cleaning honeycomb table or material to avoid

 being scratched.
˙In case of burns, please flush with cold water and consult a doctor

 immediately.
˙Wear a mask and laser safety glasses with the protection level of OD5 

(energy penetration rate 10-5) when opening the cover.

CH 1-2 Safety Precautions
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This manual is applicable to HEXA. 
Software version: 1.9.X.
Firmware version: 4.0.X.
The illustrations are mainly for macOS. 

CH 1-3
Product 
Specifications





016



CH 1-3 Product Specifications
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CH 1-4
Laser Engraving 
Principle

Laser engraving focuses a high-power laser 
beam on the surface of the engraving material 
that instantly heats or vaporizes the material to 
create an indentation or a cut in the path of the 
laser beam.





Reflective Mirrors

Second
Reflective Mirror

First
Reflective Mirror

Third
Reflective Mirror
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CH 1-4 Laser Engraving Principle

Laser Tube

Focus Lens
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Reflective Mirrors

There are three reflective mirrors inside the machine. The 
position of the first mirror is fixed, while the motor can 
move the second and third mirrors to direct the laser beam 
to any position on the work table. The second mirror moves 
forward and backward along the Y-axis, while the third 
mirror moves left and right along the X-axis.

Laser Principle

First Reflective Mirror

Second Reflective Mirror

Third Reflective 
Mirror

Optical Path
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Laser Tube

Focus Lens

The HEXA is equipped with a 60W CO2 laser. The electric 
current excites the CO2 gas inside the sealed glass tube to 
produce an invisible laser with a wavelength of 10.6 μm. The 
light emitted from the end of the laser tube is about 5 mm in 
diameter. Due to its small divergence, this laser beam can be 
transmitted inside the machine with little energy loss.

The third reflection directs the laser beam to the surface of 
the engraving material. A glass focus lens inside the laser 
head focuses the beam of about 5mm diameter to about 
0.2mm diameter to create a higher energy density that is 
sufficient to instantly burn through non-metallic materials 
such as wood and acrylic, metal materials after anodizing, or 
stainless steel after specific spry processing.

CH 1-4 Laser Engraving Principle

Third Reflective 
Mirror

Exploded view of laser head
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Start
CH 2



CH 2-1
Unboxing

Two or more people are required to  lift 
the machine to avoid injury.



1 2 3 4 5 6

8

11

12

13

9 10

15

16

14

7

Take the machine out the box and place it on a stable surface. Please keep the 
original carton and cushioning material for future use.

03

The box contains the machine and the accessory box.01

The accessory box contains : 1 | Torx screwdriver, 2 | 2.5mm hexagonal wrench, 
3 | 3mm hexagonal wrench, 4 | Double head wrench, 5 | Lubricating oil, 6 | Funnel, 
7 | Vent hose, 8 | Power cord, 9 | Double-sided tape, 10 | Clamp, 11 | USB cable, 
12 | Wi-Fi dongle, 13 | Pyramid cones, 14 | Manual, 15 | Wood piece, 16 | A4 (Letter 
size) paper.

02

CH 2-1 Unboxing
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04 Machine front：
1 ｜ Laser head, 2 ｜ Honeycomb table, 

3 ｜ Probe, 4 ｜ Height adjustment button, 
5 ｜ Door cover, 6 ｜ Touch panel, 7 ｜ Power button.

2

4

31
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Machine front：
1 ｜ Laser head, 2 ｜ Honeycomb table, 

3 ｜ Probe, 4 ｜ Height adjustment button, 
5 ｜ Door cover, 6 ｜ Touch panel, 7 ｜ Power button.

7

6

5

05 Machine rear：
1 ｜ USB-A port

2 ｜ USB-B port

3 ｜ Ethernet port

4 ｜ Power supply

5 ｜ Water pump cover

6 ｜ Ventilation fan and   
      exhaust port

CH 2-1 Unboxing

1
2

3

4 5 6

06 Machine right：
1 ｜ USB-A port

1
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CH 2-2
Assembly and 
Setup

Please read the safety precautions carefully 
before operating the machine.



01
02

03

04

05

CH 2-2 Assembly and Setup

Before engraving, you must select the language and network on the 
machine. You must also download and set up the software in order to 
pair the computer and the machine.

Prepare machine for use.

Plug the power cord into the rear of the machine and into the outlet.

Place the clamp from the smaller end of the vent hose and thread through to the 
larger end. Place the larger end of the vent hose into the exhaust port. Tighten 
the clamp using the provided double head wrench until the vent hose is secure.

Turn on the machine by pressing the power button. The first startup may take up 
to two minutes.

Follow the machine prompts: 
a. Select interface language > b. Read fire hazard warning carefully (as shown on 
the next page) > c. Run the Startup Test > d. Set up the internet connection > e. 
Tear off 2 mirror protective films. Please refer to【Connection Settings】(p.48) 
for other connection methods. Make sure the machine and any connected devices 
are on the same local area network.

After setup, please must fill the water tank to 80% full to ensure the normal 
operation of the water cooling system. Insufficient water in the cooling system 
will damage the laser tube.   Please refer to the user manual【5-4 Water changing 
and adding】（p.171）step8 for more detail.
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CH 2-3
Machine 
Interface

Introduces the machine  interface and the 
seven key functions.



A

B

DC

FE

G

CH 2-3 Machine Interface
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A：Status Bar

B：START

C：MAINTENANCE

E：NETWORK

D：APP

F：MACHINE

G：HELP CENTER

Check the machine status

Manage work files

Toggling maintenance 
mode,  repair and troubleshooting

Pairing mobile devices to machine

Check network status, network settings

Machine details, language, 
and  hardware related settings

Help Center access
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A：Status Bar
Check the machine status

The status bar shows the temperature, whether it is connected to Beam  Air, water flow, 
and door cover opening/closing status, as well as network connection type of the machine. 
Generally, clicking the status bar returns to the home page, and while carving will refresh the 
page.

Status Bar

In Progress

Cover
open

Drawer open Drawer 
closed

Wireless 
network

Cover 
closed

Ethernet 
network

Standby

Icons

Beam Air 
connected

Temperature

Cover

Water pump

Drawer

Network 
connection

BABeam Air
Temperature /

CH 2-3 Machine Interface
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There are two ways to transfer the working tasks, either via Beam Studio software or by 
USB flash drive. Either method can be used to find and use the files from "START" after 
transfer.

B：START

1. Tasks sent to the machine from Beam Studio : “Built-in Memory” > “Recent” > 
specific tasks.
The machine can store up to 15 tasks sent by Beam Studio, and recent-01.
fc will be the latest task sent.

2.  Files read from USB flash drives : USB flash drive > specific tasks.
There is no limit to the number of files that can be viewed on a USB flash drive.
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Manage work files

Select the file to display the real position of the image in the working area, the estimated 
processing time, and the real-time power and speed rate.

The origin point may be manually set before processing, and the power rate and speed rate 
can be set at any time during the process.

To set the start point manually, click      , then move the laser head from the starting position 

(0,0) to the desired position, then click OK.

CH 2-3 Machine Interface
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Toggling maintenance mode,  
repair and troubleshooting

During maintenance 
and repair, enter the 
MAINTENANCE page. 
This is intended mainly 
for hardware switch 
and signal display. It is 
highly recommended 
to operate this page 
only after reading the 
subsequent mainte-
nance chapter and/or 
under the guidance of 
customer service.

C：MAINTENANCE
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D：APP
Pairing mobile 

devices to machine

Download the Beam Go 
app and connect your 
mobile device to the 
same wireless network. 
Click on the APP and 
scan the QR code to pair 
your mobile device with 
your machine.

* Beam Go is the mobile
version of the Beam 
Studio.

CH 2-3 Machine Interface
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Check network status, 
network settings

E：NETWORK

This screen displays the network IP address and 
confirms whether the connection via Wi-Fi or 
the Ethernet cable is active (the MAC address 
for the active interface will have a value).

Advanced Settings : Manually assign a Static 
IP for the machine in this menu, including the IP 
address, subnet mask, and gateway.

Start Remote Assistance : Initiate a guided 
support session with  customer service.

Note: When using a wireless (Wi-Fi) or wired network (except for direct connection), the 
machine automatically obtains an IP address through DHCP or can be manually assigned a 
Static IP.
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F：MACHINE
Machine details, language, 

and  hardware related settings

CH 2-3 Machine Interface

CAUTION : Do not use the “Hardware Settings”, “Reset Laser Usage”, or 
“Reset to Factory” settings without express instructions from customer 
service to avoid damaging the machine.

If you have any issues, refer to section G : Help Center.
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Machine details, language, 
and  hardware related settings

The firmware upgrade process takes a few minutes. Do not turn 
off the  machine during the process.

Once the connection password is set, you must enter the connection password when 
connecting to the machine for the first time. The password can be modified or disabled.

Update the firmware to the latest version by clicking “Update to the latest Firmware”. You 
can also update the firmware through the software interface (See【Software Operation】 
“Menu” - “Machines” (p.89))

Alternatively, you may update the firmware from a USB flash drive. The storage size must be 
<= 64GB, formatted as FAT32. Rename the firmware file downloaded from the website as 
autoupdate.fxfw. Plug the USB flash drive into a USB port then restart the machine.
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G：HELP CENTER
Help Center access

CH 2-3 Machine Interface

If you have any questions, please click "HELP CENTER", scan the QR code, and search the 
Help Center on the FLUX official website for possible  solutions.
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CH 2-4
Software 
Installation
and Activation

Download the latest version of Beam Studio 
from the official FLUX website.



CH 2-4 Software Installation and Activation

v1.9.3 - macOS 10.13+

Beam Studio ( beamo / Beambox / Beambox Pro / HEXA )

Please go to the official FLUX website > “Support” > "Downloads" and select the appropriate 
version of Beam Studio from the drop-down list based on your operating system.

If you are unable to open the file because it is from an unidentified developer, 
open “System Preferences” > “Security & Privacy”, click on lock  to modify > 
“Open Anyway”.

Make sure you select the correct macOS version. Some features are not available 
on older versions of macOS. To verify your system version, select Apple Menu  > 
“About This Mac” > Version. Once the download is complete, open the file from the 
Downloads folder. Drag the application icon into the Applications folder, and open 
Beam Studio.

Make sure you select the correct operating system architecture: X86 for 32-bit 
and X64 for 64-bit. Once the download is complete, please run the installer. Beam 
Studio can be opened from the desktop or from C:\Users\User\ AppData\Local\
Programs\beam-studio\Beam Studio.

For Windows

For macOS 

【Troubleshooting】 Unable to Open Software Properly ( p.209 )
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CH 2-5
Connection 
Settings

Explains the various connection installation 
methods. Once the machine is connected, it 
can be operated from the computer.



CH 2-5 Connection Settings 

There are four ways to connect the machine to a computer: Wi-Fi, Wired Network, USB 
Connection, and Direct Connection.

1

4

2

3

Wi-Fi Wired Network

Direct
Connection

USB
Connection

Necessary equipment 
(Included in the accessory box)：

Preparation Items 
(Not included)：

Necessary equipment 
(Embeded in the machine)：

(Included in the accessory box)：

Necessary equipment  
(Not included)：

(Not included)：

- Built-in WiFi (2.4 / 5 GHz)

- WiFi dongle (2.4 GHz)

- RJ45*1 
（machine ～ router）
- RJ45*2 + router*1 
（machine ～ router / computer ～   
     router）

- USB cable (USB-B to USB-A) - RJ45*1 
（machine ～ computer）
- Plugable USB/USB-C to Ethernet 
  adapter- USB-A to USB-C adapter
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1 Wi-Fi 

2 Wired Network

a. Set up the machine network [you must use the same Wi-Fi (2.4GHz) as  your computer 
    network] :

Select “NETWORK” > “Connect to Wi-Fi” and select the Wi-Fi you want to use. Then enter 
the Wi-Fi password and press “Confirm” > “NETWORK”. Confirm the “Wireless IP” of the 
machine.
*If it didn't show your Wi-Fi name :
- Make sure your WiFi is Public. If not, please select “NETWORK” > “Connect to Other 

WiFi” > Enter the network name > Choose a security level > Enter the Wi-Fi password 
and press “Confirm” 

- Insert the Wi-Fi dongle and set antenna at 90 degrees to side USB port on the side of 
the machine to improve signal reception.

b. Select the software interface display language :
Use the drop-down list to select the language and then click “Next”.

c. Log in to your member account :
Log in to benefit from added functionality and improvements of software updates. 

d. Select the connection method：
Select “Wi-Fi”.

e. Enter the IP address of the machine to complete the setting：
Enter the IP address of the machine to complete the setup process.

a. Connect the Ethernet cable :
Connect the Ethernet cable to the Ethernet port on the rear of the machine and  to the 
router. The machine will automatically connect to the network once the installation is 
complete.

d. Log in to your member account :
Log in to benefit from added functionality and improvements of software updates.

b. Confirm the machine network :
Confirm the value of Wired Network “MAC Address” of the machine on “NETWORK” page.

e. Select the connection method :
Select “Wired Network”.

c. Select the software interface display language :
Use the drop-down list to select the language and then click “Next”.

f. Enter the IP address of the machine to complete the setting :
Enter the IP address of the machine to complete the setup process.
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CH 2-5 Connection Settings 

3 USB Connection

1. Windows :

You can also connect to the machine directly via an USB cable. 

a. Connect the USB cable：
Connect the USB cable to the USB-B port on the rear of the machine and then connect the 
USB-A side to the computer. The machine will automatically connect to the network once 
the installation is complete.

b. Confirm the machine network：	
Confirm the value of Wired Network “MAC Address” of the machine on “NETWORK” page.
Click “Settings” > “Network & Internet” > Ethernet – “Properties”. Verify that the IPv4 DNS 
servers is set to 10.55.0.17.

c. Select the software interface display language：
Use the drop-down list to select the language and then click “Next”.

d. Log in to your member account：
Log in to benefit from added functionality and improvements of software updates.
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c. Set the software interface display language：
Use the drop-down list to select the language and then click “Next”.

d. Log in to your member account：
Log in to benefit from added functionality and improvements of software updates.

e. Select the connection method：
Select "USB Connection".

f. Enter the IP address of the machine to complete the setting：
Enter the IP address of the machine, 10.55.0.1, to complete the setup process.

e. Select the connection method：
Select "USB Connection".

f. Enter the IP address of the machine to complete the setting：
Enter the IP address of the machine, 10.55.0.17, to complete the setup process.

b. Confirm the machine network：
Click “System Preferences” > “Network” > Status of USB HEXA 2 LAN: Connected.

2. masOS :

a. Connect the USB cable：
Connect the USB cable to the USB-B port on the rear of the machine and then connect the 
USB-A side to the computer. The machine will automatically connect to the network once 
the installation is complete.
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Right-click on the network you are using (Wi-Fi or Ethernet) then click “Properties” > 
“Sharing”. Check the boxes next to “Allow other network users to connect through this 
computer's Internet connection” and “Allow other network users to control or disable the 
shared Internet connection”.

CH 2-5 Connection Settings 

4 Direct Connection

a. Connect the Ethernet cable :
Connect the Ethernet cable to the Ethernet port on the rear of the machine and the 
computer.

b. Confirm the machine network :
Confirm the value of Wired Network “MAC Address” of the machine on “NETWORK” page.

You can also connect directly to your computer via an Ethernet cable.

1. Windows :  (This method applies to Windows 10)

c. Enable Internet connection sharing :
Click “Settings” > “Network & Internet” > “Change adapter options”.
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After confirmation, the word “Shared” will be displayed under that network.
In the “Network Connections” window, you will see an “Unidentified network”, which is the 
network to which the machine is connected.

e. Log in to your member account :
Log in to benefit from added functionality and improvements of software updates. 

f. Select the connection method :
Select “Direct Connection”.

d. Select the software interface display language :
Use the drop-down list to select the language and then click “Next”.
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CH 2-5 Connection Settings 

g. Enter the IP address: :
Confirm the “Wired IP” address of the machine from the panel. Enter the wired IP address 
of the machine into the computer to complete the setup process. It usually starts with 
192.168.(If it starts with 169.254, it means the computer may be set up incorrectly or the 
network cable).

2. macOS: The method is applicable to macOS environment. If you are using macOS 
Catalina, please update to at least 10.15.4.

a. Connect the Ethernet cable :
Connect the Ethernet cable to the Ethernet port on the rear of the machine and the computer.

b. Verify the machine network :
Verify that the machine has a value for Wired Network “MAC Address” on the “NETWORK” 
page.

c. Turn off the computer firewall:
Click “System Preferences” > “Security & Privacy” > “Firewall” > “Turn Off Firewall”.

d. Enable Internet connection sharing :
Click “System Preferences” > “Sharing”. Set the “Share Your Connection From” to the 
network you are using (Wi-Fi or Ethernet) then select the port to use. Click “Start” on the 
pop-up  message to enable sharing.
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e. Set the IP address of your computer to 192.168.2.1 :
Click the network icon in the upper right corner and select “Network Preferences”. Select 
the right interface (RJ45 adapter). For “Configure IPv4”, select “Using DHCP with manual 
address” from the drop-down list and set the “IPv4 address” to 192.168.2.1.

g. Log in to your member account :
Log in to benefit from added functionality and improvements of software updates.

f. Select the software interface display language :
Use the drop-down list to select the language and then click “Next”.
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CH 2-5 Connection Settings 

Return to the setup connection method screen at any time via “Machines” > 
“Machine Setup” in the menu.

h. Select the connection method :
Select “Direct Connection”.

i. Enter the IP address :
Enter the IP address of the machine to complete the setup process. The IP address usually 
starts with 192.168. (If it starts with 169.254, it means the computer may be set up incorrect-
ly or the network cable needs to unplugged and plugged in again).

Once the Connection is Complete, 
You Can Start Your First Engraving!

【Troubleshooting】Connection Issue ( p.211 ) 
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CH 2-6
Beam Studio
Tutorial

Including Camera Calibration, Engraving 
Material Focusing, and Common Software 
Functions.



CH 2-6 Beam Studio Tutorial

1. Automated Error Reporting :
If you encounter an error alert window, click “Yes” to agree to automatically upload the 
information to the development team. This will help the team identify potential software 
problems.
Note: Customer support may still request you send the relevant bug  report.

2. Camera Calibration :
To ensure accurate engraving, calibrate the camera and engraving position.
Required Items : A4 (Letter size) white paper
Note : 1. Camera calibration is required before using the camera preview function for the 
first time. 2. Refocus the platform each time to get the best results.
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a. Select Device : Select the name of the machine in use. The machine name can be verified 
on the machine page interface.

b. Place paper : Place a clean sheet of A4 (Letter size) white paper at the top-left corner of 
the working area.
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d. Draw calibration image : The machine will cut out grid lines on the paper.

CH 2-6 Beam Studio Tutorial

c. Focusing：Double click the height adjustment button to raise the honeycomb table up 
until the probe touches the paper.
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e . Place the red square : Click anywhere to cancel the prompt and move the grid lines to the 
center. Align the outside of the red square with the center square by adjusting the horizontal 
and vertical translation, rotation angle, and size ratio (you can use the arrow keys to adjust 
the values).

e-1. Red square adjustment completion position.
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CH 2-6 Beam Studio Tutorial

f. Camera Calibration completed : Once the camera calibration is completed, you can begin 
engraving.
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3. Beam Studio Tutorial : After completing the Beam Studio tutorial, you will know how to 
    carve  round and square shapes out of wood.

Steps : 

0. Select "Yes" if you would like to start the Beam Studio tutorial. 

1.  Switch to Preview Mode : Tap the Camera Preview icon on the left then select the machine
    in use.

2. Preview the Platform :
a. Place the wood piece on the platform
b. Adjust the focus
c. Close the cover
d. Preview the range of engraving material by clicking on the working interface or selecting
    a preview range

3. End Preview Mode : Select “End Preview”              。

First cut the inner object a

Then cut the outer object b

Required Items : Engraving Material: 3mm wood piece (included in the accessory box).
Note - To ensure the best engraving results, make sure to follow these steps:
1. Engrave before cutting : work from the top to the bottom of the layer. Make sure the 
engraving layer is on top and the cutting layer is on the bottom. Doing so avoids collapse 
of the object after cutting.
2. Cut inner objects before outer ones : If there are multiple cutting objects in the same 
layer, cut the inner objects first, and then the outer objects. For e.g., if object a is in object 
b, then cut object a before cutting object b.

4. Draw a Rectangle : Select a “Rectangle (M）”             to draw a square in Layer 1. Press Shift
    to to make a square.

5. Drag to Draw : Drag to draw a square on the working interface.

064



CH 2-6 Beam Studio Tutorial

6. Switch to Layer Panel : Switch to the layer             panel to set the parameters.

12. Switch to Layer Panel : Switch to the layer             panel to set the parameters.

13. Set Preset : Wood - Engraving : “Wood - Engraving”.

14. Send the File            :

a. Confirm the parameters and layer settings.
b. Select the name of the machine in use.
c. Click “Start” to start the engraving and cutting process.

9. Draw a Circle : Select “Oval (L)”             to draw a circle in layer 2 . Press Shift to make  a
    circle.

10. Drag to Draw : Drag to draw a circle in the working interface.

11.  Turn on Infill : Turn on the infill function.

7. Set Preset : Wood - Cutting : “Wood - 3mm Cutting”.

8. Add a New Layer : Name the new layer Layer 2.

- *Return to the Beam Studio tutorial  at any time by selecting “Help” > “Show
 Start Tutorial”.

- If the engraving is blurred or the color is light, please check the focus  first. If 
that does not fix the issue, inspect or adjust the optical path. See 【Maintenance】 
“Optical Path Inspection” (p.144), “Optical Path Alignment” (p.146).

【Troubleshooting】“Cooler Off” (p.185), “Door Opened” (p.187), “Homing Failed”(p.191), etc.
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Software
Operation

CH 3



This chapter introduces the software 
features and demonstrates the 4 creation 
techniques, including Beam Studio 
creation, importing work files, Trace 
Image, as well as mass production, and 
concludes with formatting instructions. 
Available for Beam Studio 1.9.X.

CH 3-1
Software 
Interface





The software interface can be divided into 5 sections

A : Toolbar

B : Layer and object management

C : Parameter Settings

D : Working Interface

E : Menu

A

D
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Vertical text

Rounded 
corner

Line spacing

Letter spacingSize

Font

Apply any fonts installed in the operating system to a Text.

Different font-styles are available with different font installed in the operating system, 
as bold, Italics, etc.

Set the Text size.

Set the space between adjacent lines 
of type.

Round the corners of a Rectangle.

Set the space between letters.

Create vertical scripts.

Style
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Infill

Fill the blank areas of texts or closed vector graphics with color, 
often used for engraving.

CH 3-1 Software Interface

Text Offset

Alignment

Set the start point of the text on the path of “Text on Path”.

Decide the alignment of the text bounding and the path in the vertical direction of 
“Text on Path”.
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Text Infill

Path Infill

Fill the blank areas of texts of “Text on Path” with color.

Fill the blank areas of paths of “Text on Path” with color.
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CH 3-1 Software Interface

081



: Infill of Pen : When the pen path is a closed vector graphics, Infill function can be 
performed.
Infill of Multiple Objects : When the selected objects do not contain an image and 
there are more than 2 drawn closed vector graphics, you can select multiple objects 
at the same time and perform the Infill function.

  Delete Multiple Objects at the same time : Delete after selecting multiple objects.
Path Infill of Text on Path : When the path of Text on Path is a closed vector graphics, 
Path Infill can be performed.

* ：Size of Text on Path：The size of text of Text on Path can only adjusted by setting a
      size value but not dragging the control points on corners of the text bounding.
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Discontinuous paths are “single” paths made up of a 
Pen, or several closed vector graphics being processed 
by Union, Subtract, Intersect, or Difference. Decompose 
is to dissolve a single discontinuous path into multiple 
paths.

Convert to Path

ACTIONS：

Replace With…

Decompose

Trace

Change an image to a new selected 
image from the computer file.

Convert a binary image to a vector 
path. The more complex the pattern, 
the longer the conversion time.

Grading Crop Sharpen

Adjust image brightness 
and contrast. Tap the 
middle of a line segment 
to create an adjustment 
point.

Remove unwanted 
content. Drag any edge 
of the crop box to 
adjust its size.

Convert a Text to paths 
for editing.

Invert

Reverse the color of an image, such as negative effect. When engraving transparent 
materials (such as acrylic), Invert is usually needed to be turned on.

Sharpness : Enhance 
the edge contrast of an 
image in an attempt to 
improve its acutance.
Radius : If Sharpness 
has a value, you can 
move the slider to 
remove noises.

CH 3-1 Software Interface
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Bevel

Create a blurred grayscale gradient for edges of bitmap graphics. Bevel is 
often used to smooth out engraving depth differences.

Array Offset

Copy a large number of objects. The 
number of rows (horizontal direction), 
the number of columns (vertical 
direction), and the object spacing (The 
spacing is the distance between centers 
of two objects.

Create concentric objects at a custom 
distance inward or outward.

Edit Path

Create Text on Path

Decompose Text on Path

Edit the path or adjust the node type.

Put a text design along a path.

Decompose a Text on Path into a Text and a Path.
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: Trace of Image : Only binary images can be converted to vector paths (one at a time).  
Grayscale images are not allowed to do Trace.

CH 3-1 Software Interface
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:  Offset of Multiple Objects : When the selected objects do not contain an image or a
Text, and there are more than 2 drawn objects, you can select multiple objects at the 
same time and perform the Offset function.
Text on Path of Multiple Objects : When a text and a path, Image or Text excluded, 
are selected at the same time, Create Text on Path can be performed.
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C：Parameter Settings

CH 3-1 Software Interface

Import

Manage Add current parameters

The suggested parame-
ters for common mate-
rials can be found in the 
drop-down list.

Export

Import all engraving 
parameters stored 
in a .json file into 
the parameter list.

Browse all parameters, and edit or de-
lete customized parameters.
“Z STEP (mm)” : When performing mul-
tiple cuts of the same path for a single 
layer (“EXECUTE” > 1), you can set the 
descending amount of the laser head for 
each execution to cut thicker materials. 
This setting is only available for autofo-
cus add-on.

Name the current parameter and save it 
to the parameter list.

Power (%) : the percentage of laser 
output power.
Speed (mm/s) : the number of millime-
ters per second the laser head moves.
Execute (times) : the number of times 
a single layer is executed for the same 
job. 

Export all parameters 
as a single .json file.

Since there are various materials, for the first time, you can choose the built-
in parameters to observe the engraving results and then fine-tune them to 
achieve the desired effect.
It is recommended that the power setting be less than 70% to reduce laser 
tube consumption.
The decline of laser tube caused by usage and time is normal, and the param-
eters should be adjusted according to the situation.

Select 
parameters
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D：Working Interface

Zoom in or zoom out the working interface

The center of the window is the area for importing images or drawing objects. Note that 
objects should be placed in the area to proceed the task.

E：Menu

The menu will explain the frequently used functions in each tab.

Beam Studio - About Beam Studio, Preferences ...

Preferences : Modify default settings such as language, machine IP address, and 
add-on.

－  100%  +

File - Open, Save, Save As, Examples, Export To ...

Edit - Optimize, Document Settings, Clear Scene ...

Examples : Use examples, including different files and material engraving tests (differ-
ent power speed combinations to find out the suitable parameters for new materials). 
Export : Export files to several formats, including BVG, SVG, PNG, JPG, FLUX task. De-
tailed information is explained in this chapter on file formats.

Optimize : Optimize the object arrangement, so that the engraving material can be 
used more effectively.
Document Settings : Adjust the engraving resolution, working area (select the model), 
and add-on switch.
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View - Show Grids, Use Layer Color ...

Machines - Test Network Settings, Calibrate Camera for machines connected to this 
network, Update Firmware ...

Window

Help - Show Start Tutorials, Bug Report, Debug Tool ...

This is the default menu for Mac systems; Windows and Linux Ubuntu do not have this 
option.

CH 3-1 Software Interface

Show Grids : Display the grids in the working interface.
Use Layer Color : Show the layer color on objects in that layer.

Test Network Settings : Check the quality of the network connection between the 
computer and the target machine.
Update Firmware : Download the firmware from the official website and save it on the 
computer, then change the machine firmware to the selected version by selecting the 
firmware file on the computer. Note: It takes a few minutes to upgrade the firmware, 
so do not turn off the machine in the middle of the process.

Bug Report : Export a bug report after an error is encountered. Please mind that the 
software cannot be reorganized or shut down before exporting a bug report. Customer 
Service guides the export of bug report files to troubleshoot Beam Studio errors.
Debug Tool : An interface for developers to debug software issues. 

089



This section contains Beam Studio 
creation, Import Image, Smart Trace, and 
mass production operation steps.

CH 3-2
Four Creation 
Techniques





Beam Studio is designed for FLUX laser engraving machines, which can effectively 
interface with other professional design software 
(see Appendix II 2-1 Design Software Recommendations) for laser engraving; if there 
are more complex objects and shapes to be engraved, it is recommended to use the 
method of Import Image, and after importing the drawings, final layout and param-
eter settings are made in Beam Studio.
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CH 3-2 Four Creation Techniques

When previewing the Smart Trace image, make sure the least amount of preview is 
done to avoid the misalignment of the image caused by stitching. If the tracing image 
is small, you can click the center of the image to place it in one camera preview screen 
when previewing. 

After confirming the position of the fixture and objects in the first editing of mass 
production project, FLUX task can be exported to the USB flash drive. In the future, 
you only need to insert the USB flash drive into the machine, focus on the engraving 
material on the fixture, and then click "START" page to select the file and directly start 
the engraving job.
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CH 3-3
File Formats

There are two main types of digital 
image files, bitmap files and vector files.



CH 3-3 File Formats

It is essential to use the vector format when cutting. The next page will 
contain a table explaining the file type of import image and the file type 
of saving, etc. There is also an overview of the layer layering method and 
the engraving resolution.

Bitmap is an image type that consist of 
numerous square pixels. Bitmap files are 
rich in details which are mostly suitable 
for photography or digital applications. 
However, the quality is related to the 
resolution so the image can get jagged 
or blurry when resized. 

Suitable for infill engraving

Long working time

Complete image quality

JPG / PNG are commonly used bitmap 
format

AI / PDF / SVG are commonly used 
vector format

Short working time

Clear contour

Suitable for outline engraving and 
cutting

Vector images are composed of paths 
defined by multiple points and are es-
pecially suitable for logos and font lay-
out. For each path, curve, or shape has 
its own formula, and can therefore be 
resized without affecting the graphic 
quality.

Bitmap 
Graphics

Vector 
Graphics

1 2
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File import and export formats :

.bvg / FLUX file (.fc) / .beam is a special file format saved by Beam Studio. If a file contains a 
bitmap, the software will export it to the bitmap preview quality in a .bvg file, while saving it 
as a .beam file will preserve the original image resolution.

*FLUX work : .fc file. .fc file is a machine-readable file that saves the software values as object 
layout, power, etc. This file format cannot be reimported into Beam Studio for editing and is 
often used for mass production work using fixture positioning.
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CH 3-3 File Formats

1.  Layer : If you have set up layers in external software, you can choose this layering 
 method.

2. Color : If there are objects of different colors in the file, you can choose  this layering method, 
and the software will create layers according to different colors.

3. Single Layer : If there is no need to set different power and speed, you can choose Single 
Layer, and the software will merge all layers into a single layer.

Layering : You can set the layering style by “Layer”, “Color”, or “Single Layer” when importing 
SVG files in Beam Studio.

Engraving Resolution : In Beam Studio, you can set the engraving resolution, i.e., engrav-
ing fineness, from low to high, at 100, 250, 500 and 1000 DPI by menu > Edit > Document 
Settings. High resolution engraving result can show more details but take longer time, on 
the contrary, low resolution engraving result is simpler but takes less time to complete.  It is 
recommended to choose the suitable engraving resolution according to the creation needs 
and time consideration.
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Material
Tips

CH 4



CH 4-1
New Materials 
Testing



Try different combinations of speed
(S: Speed) and power (P: Power)   
to find appropriate parameters 
for materials you have not worked 
with before. Sample test files can 
be imported through “Menu > File > 
Samples > Material Engraving Test. 
Test files are available for both 
engraving and cutting.

CH 4-1 New Materials Testing

Use of the engraving or cutting sample file is not recommended with thin 
material (thickness less than 0.5 mm) due to the potential for excessive 
burning resulting in oversized engraving or cutting openings; begin manual 
testing of such materials with high speed and low power (e.g., P:15, S:300).

101



In this chapter, we describe the characteris-
tics, advantages, and disadvantages (and cor-
responding potential workarounds) of 8 types 
of materials and include a comparison of ma-
terials of equal thickness.

CH 4-2
Material 
Characteristics



New Zealand MDF

1.  Good material stability, easy  to cut
2. Low level of surface embossing
    impurities

Lower density than 
Asian dense board

To reduce the risk of health hazards, use low formaldehyde 
fiberboard

CH 4-2 Material Characteristics

Glued and pressed wood fiber

1. Wood - Fiberboard, also known as medium density fiberboard (MDF) 

Material

Advantages Disadvantages

PhotoSuitability

Note

Material

Advantages Disadvantages

Asia MDF

PhotoSuitability

Note

1.  Suitable only for engraving, not easy to cut
2. Engraving produces a relatively highlevel of
   black dust

Low price

To reduce the risk of health hazards, use low formaldehyde 
fiberboard.

103



Overall: Exterior : solid wood / Interior: glued and pressed wood fiber.

1. Wood - Plywood 

Teak plywood

Cutting requires higher powerBeautiful engineered material

To reduce the risk of health hazards, use low formaldehyde 
fiberboard

Material

Advantages Disadvantages

Photo

Note

Suitability

Poplar plywood

Engraving results are 
slightly blurry due to 
lower material density

1.  Resistant to cracking and warping,
    fine grain, easy to  work with
2. Light white, straight grain
3. Light-weight material, suitable for 
    crafts and as children’s toys
4. Engraves easily with even color 

after engraving, edges are not 
easily scorched or broken

To reduce the risk of health hazards, use low formaldehyde 
fiberboard.

Material

Advantages Disadvantages

PhotoSuitability

Note
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Engraving results are 
slightly blurry due to 
lower material density

Basswood plywood

1.  Resistant to cracking and warping,
    tough, fine grain, easy to work with
2. Creamy white, fine and straight grain 
3. Smooth surface obtainable by sanding, 
    staining, and polishing

To reduce the risk of health hazards, use low formaldehyde 
fiberboard

Material

Advantages Disadvantages

PhotoSuitability

Note

Plain plywood

Texture quality is poor, 
slightly rough

1. More complex material, harder 
texture, less likely to split when 
cut

2. Used for building construction
    or crafts

To reduce the risk of health hazards, use low formaldehyde 
fiberboard

Material

Advantages Disadvantages

PhotoSuitability

Note

CH 4-2 Material Characteristics
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Walnut plywood

Dark wood color 
makes engraving  
effect less apparent

1.  Resistant to cracking and warping, 
    tough, fine grain, easy to work with
2. Coffee color, fine and straight grain of 
    different shades.
3. Smooth surface obtainable by sanding, 
    staining, and polishing

Material

Advantages Disadvantages

PhotoSuitability

Note

To reduce the risk of health hazards, use low formaldehyde 
fiberboard

Solid wood

Depth of engraving may be 
uneven due to growth rings

Naturally varying 
grain characteristics

Growth rings are naturally uneven in wood density

Natural, healthy, non-toxic, eco-friendly.

1. Wood - Solid Wood 

Material

Advantages Disadvantages

PhotoSuitability

Note
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Problem Solution Possible Drawback

Uneven

1. To deepen the color: 
   lower the speed
2. To deepen the cutting depth :
    increase the power

1. Use lower-density wood
2. Clean with a small amount of 
    alcohol

1. Moisture may warp the wood
2. Excessive alcohol causestar to
    penetrate into the wood

Before processing
1.  Cover the surface of the engraving
   material with paper tape
2. Slightly moisten the wood

After processing
1. Remove the burn marks with
   sandpaper

Before processing
1. Tape residue
2. Bumps on the surface
After processing
1. Scratch marks

1. Larger burn marks
2. Decreased precision and
    distorted proportions

Engraving 
Burn Marks

Cutting 
Burn Marks

Common Problems with Wood :

Polyurethane (PU)

1.  Base cloth: PU looks much thicker than
    PVC from the side
2. Texture: PU feels softer than PVC

Incomplete burning will produce toxic fumes

_

Base layer: mostly woven fabric; adhesive layer; resin layer : PU and PVC, etc.

2. Leather - Synthetic Leather 

Material

Advantages Disadvantages

PhotoSuitability

Note

CH 4-2 Material Characteristics
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Polyvinyl chloride (PVC)

Engraving produces corrosive 
gas which causes the screws in 
the machine to rust

Hazardous materials

_

Material

Advantages Disadvantages

PhotoSuitability

Note

Vegetable tanned leather

Natural color, absorbs oil, moist, firm

Supple, soft, malleable

2. Leather - Genuine Leather 

_

_

Material

Advantages Disadvantages

Photo

Note

Suitability
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Chrome tanned leather

Malleable, water and stain resistant, 
does not easily fade _

Burning produces toxic gas, not suitable for laser processing

Material

Advantages Disadvantages

PhotoSuitability

Note

Scorching and
curling

Wet the whole piece of 
leather before processing

Use air purifier in work 
space

Air filter foam sheet is consumable

Leather wrinkles after drying

Heavy smell 
from laser

Common Problems with Leather 

Problem Solution Possible Drawback

CH 4-2 Material Characteristics
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Acrylic

Produces dust during 
processingNo burn marks 

Make sure that the material is not plastic (PVC, PC)

Strong, tough, durable

3. Acrylic - Acrylic, also known as polymethyl methacrylate (PMMA), plexiglass

Material

Advantages Disadvantages

PhotoSuitability

Note

Scratches
After processing
Use plastic-specific abrasive  
to remove 

Some acrylics contain high 
levels of impurities; use better 
quality acrylics.

Big price difference between highest- 
and lower-grade acrylics.

1.  Keep the protective film on
when not engraving gradient 
images

2. Clean with a small amount  
    of alcohol

Using too much alcohol with some 
acrylics may cause surface defects, 
such as cracks. But gently heating 
acrylic in an oven may help repair 
minor cracks.

May only be able to remove shallow 
scratches

Cloudyiness

Explosive 
sounds when 

cut

Common Problems with Acrylic 

Problem Solution Possible Drawback
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White paper

_

Widely available
Warps when burnt at high 
temperature; make sure the 
position of the paper is fixed

Widely available

4. Paper - White Paper 

Material

Advantages Disadvantages

PhotoSuitability

Note

Corrugated cardboard

Higher power settings may cause fire hazard 

Easy to obtain, does not require 
high power to process, suitable 
for structural works

Uneven surface, make sure 
focus is accurate

Cheap, structurally strong, suitable for three-dimensional art pieces

4. Paper - Corrugated Cardboard 

Material

Advantages Disadvantages

PhotoSuitability

Note

CH 4-2 Material Characteristics
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Yellowish 
carbonized 
burn edges

Before processing
Paper material impacts the amount and 
color of the ashes; use paper with PP 
material.
After processing
Use low-viscosity material such as 
multi-purpose putty to remove the 
residue.

Before processing
Slightly moisten the corrugated

Cardboard deforms 
more easily (surface is 
uneven)

corrugated 
cardboard 

burns

Common Problems with Paper 

_

Problem Solution Possible Drawback

1.  For your safety, clean engraved glass with a brush instead
    of with bare hands
2. Leaded glass is not suitable for laser processing because 
    glass may shatter

Glass

Chips easily during processing, 
engraving results may vary 
depending on glass material

Easy to obtain, e.g. 
beverage bottles

5. Glass 

Material

Advantages Disadvantages

PhotoSuitability

Note
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Crackin 1. Choose thicker glass
2. Reduce power

Laser processing of some glass materials 
will result in cracking. This is due to mate-
rial characteristics and cannot be avoided

Common Problems with Glass 

Problem Solution Possible Drawback

Anodized aluminum alloy

_

Obvious engraving effect with 
low power; no loss of color

Using too much power may 
produce blurry image or 
brown  color

Wear-resistant and textured

6. Metal - Anodized Aluminum Alloy Surface 

Material

Advantages Disadvantages

PhotoSuitability

Note

CH 4-2 Material Characteristics

113



Spray-coated stainless steel

1.  Oxidize the stainless steel with FLUX Steel Engraving Spray
    before engraving
2 . Wear gloves when using the spray to avoid  staining the skin

Evenly applied spray-coating
makes it easy to engrave 
stainless steel 

The engraving result is not 
sharp and is only suitable for 
artwork and experimentation

6. Metal - Spray - Coated Stainless Steell 

Material

Advantages Disadvantages

PhotoSuitability

Caution

Stone

_

Suitability for engraving 
depend on exact stone, shale 
and marble are more suitable

Engraving effect is usually not 
apparent on lighter-colored stone

There are differences between artificial materials and natural materials, and textures vary.

7. Other Engravable Materials - Stone

Material

Advantages Disadvantages

PhotoSuitability

Note
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Cement

_

Textures can be easily created 
on the cement surface

Particle size of cements will affect 
the overall engraving result

7. Other Engravable Materials - Cement 

Material

Advantages Disadvantages

PhotoSuitability

Note

EVA foam

_

Can be cut at extremely low 
power, low chance of burn 
marks

Due to flammability and pungent 
odor, good ventilation is required 
while engraving

7. Other Engravable Materials - EVA Foam

Lightweight and low density, commonly used in molds and cushioning materials

Material

Advantages Disadvantages

PhotoSuitability

Note

CH 4-2 Material Characteristics
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Cotton and linen fabrics

_

Can be engraved at 
low power

Due to flammability and pungent 
odor, good ventilation is required 
while engraving

7. Other Engravable Materials - Cotton and Linen Fabrics 

Material

Advantages

PhotoSuitability

Caution

Disadvantages

Silicone

Reflective mirrors must be cleaned more frequently  to prevent 
dust from sticking to the mirrors and affecting the laser output

Eco-friendly, 
non-toxic

Instantly hardens when heated, and 
therefore not suitable for cutting; 
cut with scissors or blades

7. Other Engravable Materials - Silicone 

Material

Advantages Disadvantages

PhotoSuitability

Note
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Engraving is 
not visible

Increase power and 
repeat engraving

Clean with a toothbrush Wear and tear of toothbrush

Cut with other tools, e.g., 
scissors, utility knife

Cuts may be uneven

Image quality may be poorer

Incomplete cut

Silicone is dusty 
after engraving

Common Problems with Silicone

Problem Solution Possible Drawback

Polyvinyl chloride (PVC)

_

Burning generates carcinogens and corrosive gases 
hazardous to health

Jagged melting marks on edges

Usually appears as stickers, thin films, or transparent sheets

8. Hazardous Materials - Polyvinyl Chloride (PVC) 

Material

Advantages Disadvantages

PhotoSuitability

Note

CH 4-2 Material Characteristics
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Plastics with chlorine, benzene, ammonia, 
fluorine, phenol, or aldehyde in its scien-
tific name or with a hexagonal benzene 
ring in its molecular formula

Acrylonitrile butadiene
styrene (ABS)

_ _

Carcinogenic substances may be generated when 
incompletely burned

8. Hazardous Materials - Acrylonitrile Butadiene Styrene (ABS) 

Material

Advantages Disadvantages

PhotoSuitability

Note

_ _

Burning will likely generate carcinogenic and toxic substances

Examples of unsuitable resins :

Hexagonal 
Benzene Ring

8. Hazardous Materials - Plastics with Chlorine, Benzene, Ammonia, Fluorine, Phenol, or
Aldehyde in its Scientific Name or with a Hexagonal Benzene Ring in its Molecular 
Formula 

Material

Advantages Disadvantages

PhotoSuitability

Note
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Materials are of 
equal thickness Wood

Easy Easy

Strong

Medium

MediumMedium

High

High

Low Low

Low LowHigh

Medium

Medium

Strong Weak

Easy Difficult

None

None None

Difficult

*Weak

* : metallic dusty smell

PaperLeather Glass MetalAcrylic

Processing difficulty

Strength of smell

Amount of tar

Dustiness

Gradient effect

Laser reflects off   
material, e.g. glossy 

metals

Avoid using, except for spray oxidized 
stainless steel

Elevate the material away from 
the honeycomb table   to avoid 
burn marks on the material from 
laser reflections

Laser penetrates
 material and reflects off 

the honeycomb table

Non-material-specific Problems

Material Comparison Table

_

_

The above comparisons are based on common materials. 
Testing on your specific material may yield different results.

Problem Solution Possible Drawback

CH 4-2 Material Characteristics
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Maintenance
CH 5



To facilitate maintenance and repair instruc-
tions, this section divides the machine into 
three general areas: the panel, the working 
area, and the back cover.

CH 5-1
Maintenance



* : Necessary maintenance

Area Maintenance Content Maintenance Frequency

MAINTENANCE page*p.125

p.129

p.131

p.134

p.136

p.138

p.144

p.146

p.159

p.161

Once every 1 month

Screen cleaning Once every 2 weeks

Lubricatingt*

Once every 2 weeks

Honeycomb table cleaning* Once an operation

- Wood, Plywood

Chassis cleaning* Once an operation

- Acrylic Once every 1 week

Mirrors and lens cleaning* Once every 1~2 weeks

- Leather Once every 2 weeks

Optical path inspection*
When first unboxing, after 
laser tube replacement 
Once every 1 month

- Paper Once an operation day

Laser tube replacement
Depends on power, usage 
hours, room temperature, 
water temperature, etc.

Optical path alignment Adjust when the optical 
path misaligned

Water changing and adding* Once every 3 months

Door cover cleaning Once every 2 weeks

Ventilation fan cleaning Once every 1 month

Panel

Working 
Area

Back 
Cover

p.171

p.178

CH 5-1 Maintenance

Maintenance of the machine according to the maintenance frequency can effectively reduce 
the chance of failure.

【Appendix 3】 Maintenance Checklist (p.245) provides maintenance record sheet for users 
  to use. 
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The panel contains the machine interface 
and the components underneath.

CH 5-2
Panel



CH 5-2 Panel

MAINTENANCE Page : 
Function Test

It is recommended to check 
once every 1 month.

Preparation Items : None

Maintenance Steps : After homing successfully, check the status display and switches except 
for the “Laser Pulse”, and the standards are as follows

Status display

Switches

125



Status display Test method

After pressing “Motors” to release the 
motors, move the laser head to the left-
most side of the machine until hearing a 
clicking sound. (Trigger switch)

Manually press the top limit switch in 
the lower right corner until hearing a 
clicking sound. (Trigger switch)

Manually press the bottom limit switch 
in the lower right corner until hearing a 
clicking sound. (Trigger switch)

Press the “Pump” switch (start pump)

Open and close the door cover

Open and close the drawer

Opened

Opened

Closed

Closed

Icon

Door cover

Drawer

Water pump

Z-axis top 
limit switch

Z-axis bottom 
limit switch

X-axis
limit switch

Y-axis
limit switch

After pressing “Motors” to release the 
motors, move the laser head to the back-
most side of the machine until hearing a 
clicking sound. (Trigger switch)

On Off

Not 
triggered

Not 
triggered

Not 
triggered

Not 
triggered

Triggered

Triggered

Triggered

Triggered
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CH 5-2 Panel

- Pump : Open the door cover to check whether the blue light of the water pump is on (as 
   shown below) and whether the water pump icon on the screen is          .     

Switches :

- Camera : Check whether the camera view appears on the screen and move the laser head 
to observe whether the screen keeps changing with the camera movement. (Camera view 
is updated every 3 seconds)

- Motors : Check whether the laser head can move normally along the X-axis linear rail and
Y-axis guiding rods.

- Air Pump : Check whether there is air coming out of the laser outlet with a piece of paper, 
as shown above.
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Cam Led

Work Led

- Ventilator : After clicking, there will be a sound of acceleration and rotation, like the sound 
  of aircraft taking off.
- Backlight : The screen will turn black and then light up after clicking.
- TouchSig : The screen will be untouchable for 3 seconds after clicking.
- Cam Led : The light next to the camera, check if it can be normally illuminated, as shown 
  below.
- Work Led : At the front side and back side of the chassis, check if the light can be normally 
  illuminated, as shown below.
 
If there is any abnormality, please go to 【Troubleshooting】(p.183)  to find the solution.
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1 2

CH 5-2 Panel

Screen Cleaning It is recommended to check 
once every 2 weeks.

Maintenance Steps : If the screen is dirty, spray a small amount of alcohol on a cleaning cloth 
                                  and wipe the screen lightly.

Preparation Items : Self-preparation : 1｜75%~99% alcohol, 2｜Cleaning cloth
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The working area includes the working 
range and the laser optical path.

CH 5-3 
Working Area



CH 5-3 Working Area

Lubricating It is recommended to clean and 
re-lubricate once every 1 - 2 weeks.

1 2 3

Maintenance Steps : Clean the Y-axis guiding rods, X-axis linear rail and 4 lead screws                                  
                                  regularly to extend the service life of the parts.

Preparation Items : Self-Preparation : 1｜Paper towel or tissue paper, 2｜Cotton swab or brush 
Included in the accessory box : 3｜Lubricating oil
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1. Cleaning : Use paper towel or tissue paper to wipe the oil and dust on the Y-axis  guiding 
   rods, X-axis linear rail and 4 lead screws.

1.

1. Y-axis  guiding rods

2. X-axis linear rail

3. 4 lead screws (p.133 bottom)

4. Height adjustment button 
     (p.133 bottom)

2.
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3.

3.

3.

3.

X-axis linear rail detail

Lubricating position

Lubricating position

4.

CH 5-3 Working Area

- Y-axis guiding rods and X-axis linear rail : Use at the Y-axis guiding rods on 
both sides of the working range > Apply evenly above and on both sides of the X-axis 
linear rail > Manually move the laser head left and right and forwards and backwards 3 - 5 
times to distribute the lubricating oil evenly.

- Lead screws : Apply at the surface of the lead screws > Press the "Up" button and the
  "Down" button to elevate and lower the honeycomb table once to distribute the lubri    
   cating oil evenly.

2. Oiling : Dip cotton swab or brush in the lubricating oil >
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1 2 3

Honeycomb 
Table Cleaning

It is recommended to clean it once 
an operation.

Preparation Items : Self-preparation : 1｜Vacuum cleaner or brush, 2｜Paper towel or tissue
                                 paper, 3｜Air conditioner coil foaming cleaner

Notes : To avoid the possible fire hazard due to the left of small pieces of engraving materials
on or beneath the honeybomb table, it is recommended to clean the honeycomb table 
right after use.
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Probe

Height adjustment button

CH 5-3 Working Area

Maintenance Steps:

1. Take the honeycomb table out : Move the laser head to the upper right of the working 
range > Press on the “Autofocus” button for 2 seconds to do the Z-axis homing > Lift up 
the honeycomb table handles, hold the two sides of the honeycomb table, and pull it out.

2. Clean the honeycomb table : Use a vacuum cleaner or brush to clean the large residue and
dust > Spray the honeycomb table with the air conditioner coil foaming cleaner  > Wait for 
the tar oil to soften, then wipe it with paper towel or tissue paper to remove the tar.

3. Put the honeycomb table back : Place the honeycomb table at a 45-degree angle into the 
chassis and lay it flat.

- The mesh part of the honeycomb table is relatively sharp, so please be careful 
  when holding.
- Perform a 2-second press on the "Autofocus" button to do the Z-axis homing to 
  avoid hitting the probe while taking out the honeycomb table.
- If the laser head cannot be moved, please click “MAINTENANCE” on the screen >
  “Motors” to release the motors.
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Chassis Cleaning

1 2 3

Preparation Items : Self-preparation : 1｜Vacuum cleaner or brush, 2｜75%~99% alcohol, 
                                3｜Paper towel or tissue paper.

It is recommended to clean it once 
an operation.

Notes : To avoid the possible fire hazard due to the left of small pieces of engraving materials
on or beneath the honeybomb table, it is recommended to clean the chassis right after 
use.
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CH 5-3 Working Area

- The mesh part of the honeycomb table is relatively sharp, so please be careful 
  when holding.
- Perform a 2-second press on the "Autofocus" button to do the Z-axis homing to 
  avoid hitting the probe while taking out the honeycomb table.
- If the laser head cannot be moved, please click “MAINTENANCE” on the screen >
  “Motors” to release the motors.

Maintenance Steps:

1. Take the honeycomb table out : Move the laser head to the upper right of the working
range > Press on the “Autofocus” button for 2 seconds to do the Z-axis homing > Lift up 
the honeycomb table handles, hold the two sides of the honeycomb table, and pull it out.

2. Clean the chassis : Use a vacuum cleaner or brush to clean the large residue and dust, or 
gather them on the drawer, then open the drawer from the outside or push it out from the 
inside of the chassis for cleaning.

3. Put the honeycomb table back : Place the honeycomb table at a 45-degree angle into the
chassis and lay it flat.
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Mirrors and 
Lens Cleaning

Depending on the frequency of usage and 
material,it is recommended to clean the 
mirrors and lens once every 1 - 2 weeks.

1 2

Preparation Items : 1｜Cotton swab, 2｜75%~99% alcohol

Maintenance Steps : If the engraving material is paper or wood, it is more likely to cause dust 
and tar oil to stick on the reflective mirrors. You can use cotton swabs 
with a small amount of alcohol to clean and wipe until the mirror surface 
is free of stains.
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CH 5-3 Working Area

After cleaning, the mirrors and lens should not be left with water marks to 
avoid oxidation which may have an effect on the laser power, and should 
not be wiped excessively as well.

There are 3 reflective mirrors and 1 focus lens that need to be cleaned in HEXA, and their 
positions are shown in the picture.

Maintenance Steps:

1. Clean the first reflective mirror : The first reflective mirror is located at the left side of the
laser tube facing the chassis. You can open the back cover or wipe it from the front hole. 
As shown below.

First reflective mirror

Second
reflective
mirror

Third
reflective
mirror

Focus lens
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3. Clean the third reflective mirror : The third reflective mirror is in the  triangular mirror holder
    which is on the X-axis linear rail.

2. Clean the second reflective mirror : The second reflective mirror is located on the left Y-axis 
    guiding rod facing the chassis.
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Laser head cover

Screws

CH 5-3 Working Area

4. Clean the focus lens : The focus lens is located under the third reflective mirror,  inside the
     laser head. 

a. Remove the honeycomb table >

b. Loosen 2 screws on the laser head cover and then move the cover aside >
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Nozzle fastening ring

c. Unscrew the nozzle fastening ring clockwise > Remove the laser head, and please avoid 
    the focus lens from being popped out >

d. Take out the focus lens and then clean it.
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CH 5-3 Working Area

Flat sideConvex side

If not installed according to the direction of the instruction, it may cause 
inaccurate focus, resulting in blurred engraving or inability to cut.

5. Put the focus lens back : The lens has an orientation, the convex side faces up, the flat 
side faces down.
(Hold the edge of the focus lens on your hand and look towards the focus lens, you can 
see yourself on the convex side and cannot see yourself on the flat side.)
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Optical Path 
Inspection

When first unboxing, after laser tube 
replacement, once every 1 month.

Notes : The optical path will be changed due to transportation and vibration of the working,
so regular inspection is necessary to ensure the correct laser optical path, so that the 
machine can engrave evenly and cut normally.
Necessary inspection conditions : 1. The first time unboxing after long distance trans-
portation. 2. After replacement of the laser tube. 3. For regular maintenance, it is 
recommended to check once a month.

Preparation Items : Included in the accessory box : 1｜Double-sided tape
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CH 5-3 Working Area

First reflective mirror

Second
reflective
mirror

Third
reflective
mirror

Focus lens

Top right

Middle rightMiddle left Center

Bottom rightBottom left

Top left

X-axis

Y-axis

Z-axis

Inspection Steps :

1. Get the laser spots in the two corners : Hit the “MAINTENANCE” of the machine > Select 
“Motors” > Move the laser head to the top left position > Put the double-sided tape on the 
laser head outlet > Close the door cover > Make sure the laser “Power” is the default x 1.00 
> Click “Laser Pulse” > Open the door cover > Make sure the laser spot is a full circle > Move 
the laser head to the bottom right > Put the double-sided tape on the laser head outlet > 
Close the door cover > Click “Laser Pulse” > Open the door cover > Make sure the laser spot 
is a full circle. Get a total of 2 laser spots on the top left and bottom right.

 Unable to get a full circle at both corners, you need to go through the 
【Maintenance】 Optical Path Alignment (p.146).
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Optical Path 
Alignment

Once every 1 month

1 2 43

If the optical path is misaligned, the optical path should be realigned.
Signs of misaligned optical path : 1. engraved patterns will be deeper to lighter in a certain 
direction; 2. the cut section is not vertical after cutting.

Preparation Items : Included in the accessory box: 1｜2.5mm hexagonal wrench, 2｜Torx 
                                 screwdriver, 3｜Double head wrench, 4｜Double-sided tape
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CH 5-3 Working Area

First reflective mirror

Second
reflective
mirror

Third
reflective
mirror

Focus lens

Top right

Middle rightMiddle left Center

Bottom rightBottom left

Top left

X-axis

Y-axis

Z-axis

Alignment Instructions :

1. The Y-axis direction is related to the first reflective mirror. After the first reflective mirror
is correctly adjusted, the laser spot got at bottom left position should coincide with that 
got at top left position. When adjusting the first reflective mirror, put the double-sided 
tape on the second reflective mirror.

2. The X-axis direction is related to the second reflective mirror. After the second reflective 
mirror is adjusted, laser spot got at middle right position should coincide with that got at 
middle left position. When adjusting the second reflective mirror, put the double-sided 
tape on the third reflective mirror.

3. The Z-axis direction is related to the third reflective mirror. After the third reflective mirror 
is adjusted, the laser spot should be in the center of the laser outlet. When adjusting the 
third reflective mirror, put the double-sided tape on the laser outlet.

1.  Do not open the door cover when laser pulsing is in progress, otherwise the
    laser will not emit light due to the protection mechanism.
2. When aligning the optical path, the “Power” can be set to x0.50 in the

“MAINTENANCE” page to avoid the laser spot being too large to judge the laser 
spot offset direction precisely. When the alignment is completed, the “Power” 
needs to be restored tothe original po wer setting of x1.00 to avoid insufficient 
power during use.

3. If there is an abnormal cracking sound when starting the laser pulse, please 
disconnect the power and stop using it immediately. 【Troubleshooting】No Laser 
Beam Output. (p.200)

4. Please use the Torx screwdriver to remove the 2 screws on both sides of the
    back cover and then lift the cover.
5. Since there are threadlockers on the nuts of the first and second reflective

mirrors fixing mirror adjustment screws, dropping a small amount of alcohol on 
those nuts is suggested to soften the threadlockers before turning the nuts.
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2 screws

Alignment Steps:

Laser tube
Target : To confirm the laser spot is on the first reflective mirror.
Method :
1.  Lift the back cover : Please use the Torx screwdriver to remove the 2 screws on both sides
    of the back cover and then lift the cover. 
2. Paste the tape : Take a piece of double-sided tape and paste it on the round metal frame 
    of the first reflective mirror.
3. Obtain laser spot on the first reflective mirror : Close the door cover > Click the “MAIN
     TENANCE” on the screen > Click “Laser Pulse” > Open the door cover > Make sure the laser   
    spot is within the mirror, avoiding the frame of the mirror.

If the laser spot is on the frame, it indicates that the optical path is shifted too 
much, so you need to move the first reflective mirror assembly to make the laser 
spot fall into the mirror. (Use 2.5mm hexagonal wrench to loosen the 2 screws 
on the bottom of the first reflective mirror assembly) > Adjust the position of 
the assembly > Tighten the screws back). If the laser spot is weak (laser pulse at 
screen power x 1.00, it takes more than 3 shots before the laser spot is visible), 
then the laser tube should be replaced. 【Maintenance】Laser Tube Replacement. 
(p.161)

Reflective mirror

Mirror frame
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Bottom left 
laser spot

CH 5-3 Working Area

First reflective mirror
Target : To make the bottom left spot coincide with the top left spot. 
Method :
1. Release the motors and paste the tape : Click the “MAINTENANCE” of the machine to 

finish the X and Y-axis homing  > Click "Motors" > Take a piece of double-sided tape and 
paste it on the metal frame of the second reflective mirror.

2. Obtain the top left laser spot : Move the laser head to the top left manually > Close the
door cover > Click “Laser Pulse” > Open the door cover > Confirm the laser spot position. 
You need to observe how the next (bottom left) laser spot moves.

3. Obtain the bottom left laser spot: Move the laser head to the bottom left manually > Close
the door cover > Click “Laser Pulse” > Open the door cover > Confirm whether the bottom 
and top left are overlapped at the same position and avoid the reflective mirror frame. As 
shown in the picture above. If the laser spots are not completely overlapped, adjust the 
mirror adjustment screw behind the first reflective mirror according to the direction of la-
ser spot movement, so that the bottom left laser spot position moves to the top left laser 
spot position. 

4. Adjust the first reflective mirror: Drop a small amount of alcohol on the nut to soften the 
threadlocker > Use a double head wrench to loosen the nut without turning the mirror ad-
justment screw > Tighten or loosen the mirror adjustment screw according to the direction 
of laser spot movement (control direction explained later) > Repeat steps 2, 3, 4 until the 
bottom left laser spot overlap with the top left laser spot (if you can no longer determine 
the direction of laser spot movement, you need to reapply the double-sided tape) > After 
finishing the adjustment, tighten the nut without turning the mirror adjustment screw.

After confirming that the bottom and top left spots coincide and avoiding the reflective 
mirror frame, adjust the second reflective mirror.

If there is no laser spot at the bottom left, please move to the middle left for 
correction first, and then change back to the top left and bottom left for correction 

after confirming that the middle left and top left points can be overlapped.
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Tightening or loosening screw is equivalent to adjusting the angle of the reflective mirror.

- When turning the yellow screw, the red and green screw link can be considered 
as the axis of rotation.
By tightening the yellow screw (clockwise), you can think of pushing the mirror from the 
upper left with the red and green as the axis, and the laser spot will move down to the lower 
right. Loosening the yellow screw (counterclockwise), you can think of the red and green 
as the axis to move the mirror backward in the upper left, and the laser spot will move up 
to the upper left.

- When you turn the green screw, you can think of the yellow and red screw link as 
the axis of rotation.
By tightening the green screw (clockwise), you can think of the yellow and red as the axis 
to push the mirror from the upper right, and the laser spot will move to the left. Loosening 
the green screw (counterclockwise), you can think of the yellow and red as the axis to move 
the mirror backward in the upper right, and the laser spot will move to the right.

- When turning the red screw, think of the yellow and green screw link as the axis 
of rotation.
By tightening the red screw clockwise, you can think of the yellow and green as the axis to 
push the mirror from the lower left, and the laser spot will move up. If you loosen the red 
screw (counterclockwise), you can think of the yellow and green as the axis to move the 
mirror backward in the lower left, and the laser spot will move downward.

The rotation directions of 
mirror adjustment screws of 

the first reflective mirror.

The moving paths of the laser spots 
on the double-sided tape on the 

second reflective mirror.

Screw Nut
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CH 5-3 Working Area

Second reflective mirror
Target: To make the middle right spot coincide with the middle left spot.
Method:
1. Paste the tape : Take a piece of double-sided tape and paste it on the round 

metal frame of the third reflective mirror.
2. Obtain the middle left laser spot : Move the laser head to the middle left 

manually > Close the door cover > Click “Laser Pulse” > Open the door cover > Confirm the 
laser spot position. You need to observe how the next (center) laser spot moves.

3. Obtain the center laser spot : Move the laser head to the center manually >  
Close the door cover > Click “Laser Pulse” > Open the door cover > Confirm whether the 
center and middle left overlap in the same position. You need to observe how the next 
(middle right) laser spot moves.

4. Obtain the middle right laser spot : Move the laser head to the middle right 
manually > Close the door cover > Click “Laser Pulse” > Open the door cover > Confirm 
whether the spots overlap in the same position. If they are not completely overlapped, 
adjust the mirror adjustment screw behind the second reflective mirror according to the 
direction of laser spot movement, so that the middle right laser spot position moves to the 
middle left laser spot position.

5. Adjust the second reflective mirror : Drop a small amount of alcohol on the nut  
to soften the threadlocker > Use a double head wrench to loosen the nut without turning 
the mirror adjustment screw > Tighten or loosen the mirror adjustment screw according to 
the direction of laser spot movement (control direction is explained later) > Repeat steps 
2, 4 and 5 until the middle right laser spot overlap with the middle left laser spot (if you 
can no longer judge the direction of laser spot movement, you need to reapply the dou-
ble-sided tape) > After finishing the adjustment, tighten the nut without turning the mirror 
adjustment screw.
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The rotation directions of mirror 
adjustment screws of the second 

reflective mirror.

The moving paths of the laser 
spots on the double-sided tape 

on the third reflective mirror.

Screw Nut

6. Confirm the spots of the middle right and the middle left overlap : Take a piece of
double-sided tape and put it on the frame of the third reflective mirror > Repeat steps 
2 and 4 to confirm the overlap of the middle right and middle left spots and avoid the 
reflective mirror frame, then fine-tune the laser head assembly position so that the over-
lapping spot is located on the perpendicular line of the round metal frame (black solid 
line area in the figure).

152



CH 5-3 Working Area

4 hexagonal screws

Moving direction

7. Fine-tune the laser head assembly position : Use a 2.5mm hexagonal wrench to loosen 
the 4 hexagonal screws on the X-axis linear rail that hold the laser head assembly in place > 
Move the laser head forward or backward depending on the position of the spot > Roughly 
tighten the 4 screws > Move the laser head to the center manually > Close the door cover > 
Click “Laser Pulse” > Open the door cover > Confirm that the spot is on the perpendicular 
line > Move the laser head to the chassis front > Click “Camera” and make sure the upper 
and lower edges of the camera are parallel to the machine chassis > Fix the 4 hexagonal 
screws of the laser head assembly. After confirming that the middle right and middle left 
spots are on the perpendicular line of the round metal frame, you can adjust the third re-
flective mirror.
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Third reflective mirror
Target: To make the laser spot hit the center of the laser outlet.
Method:
1. Paste the tape : Take a piece of double-sided tape and put it on the laser head outlet > 

Gently press the double-sided tape to make a circle of laser head outlet indentation on the 
tape's adhesive surface.

2. Obtain the center laser spot : Move the laser head to the center manually > Close the door 
cover > Click “Laser Pulse” > Open the door cover > Make sure the laser spot is in the cen-
ter of the laser outlet. If it is not in the center of the circle, you need to adjust the mirror 
adjustment screw behind the third reflective mirror according to the position of the spot.

3. Adjust the third reflective mirror : Use a double head wrench to loosen the nut without 
turning the mirror adjustment screw > Tighten or loosen the mirror adjustment screw ac-
cording to the direction of the laser spot movement (the control direction is explained 
later) > Repeat steps 3 and 4 until the laser spot falls in the center of the beam outlet (if 
you can no longer judge the laser spot movement direction, you need to reapply the dou-
ble-sided tape) > After finishing the adjustment, tighten the nut without turning the mirror 
adjustment screw.

The adjustment method is different from the first and second reflective mirror, because the 
position of the mount under the third reflective mirror is fixed, so when the screw is tight-
ened, the mount will not move, but the reflective mirror will be ejected.
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CH 5-3 Working Area

- When turning the yellow screw, the red and green screw link can be regarded as the axis 
of rotation. 
Tightening the yellow screw (clockwise), you can think of moving the mirror backward in the 
upper right with red and green as the axis, and the laser spot will move to the upper right. 
Loosening the yellow screw (counterclockwise), you can think of the red and green as the 
axis to push the mirror from the upper right, and the laser spot will move to the lower left.

- When turning the green screw, the yellow and red screw link can be regarded as 
the axis of rotation. 
Tightening the green screw (clockwise), you can think of moving the mirror backward in the 
upper left with the yellow and red as the axis, and the laser spot will move to the left. Loos-
ening the green screw (counterclockwise), you can think of the yellow and red as the axis 
to push the reflective mirror from the upper left, and the laser spot will move to the right.

- When turning the red screw, the yellow and green screw link can be regarded as 
the rotating axis.
Tightening the red screw (clockwise), you can think of moving the mirror backward in the 
lower right with the yellow and green as the axis, and the laser spot will move downward. 
Loosening the red screw (counterclockwise), you can think of the yellow and green as the 
axis to push the reflective mirror from the lower left, and the laser spot will move upward.
After completing the above adjustments, you can ensure that the laser beam output is uni-
form at any location in the working area to achieve normal working requirements. Please 
perform "Calibrate Camera" again before use. 【Beam Studio Tutorial】 Camera Calibration. 
(p.058)
If the laser beam output verticality is strictly required, you can further adjust the verticality 
of the optical path.

The rotation directions of 
mirror adjustment screws of 

the third reflective mirror.

The moving paths of the laser 
spots on the double-sided 

tape on the laser head outlet.

Screw

Nut
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Reflective Mirror 
Round Frame

Advanced adjustment : Verticality of the optical path (selective adjustment)
Target:To adjust the laser spots obtained from the laser head socket and from the laser head 
outlet to the center of the circles.
Method:
1.  Paste the tape : Take a piece of double-sided tape and paste it flat on the frame of the third
    reflective mirror.
2. Get the center laser spot : Move the laser head to the center manually > Close the door 
    cover > Click “Laser Pulse” > Open the door cover.
3. Measure the center offset value : Measure the distance between the center of the spot and 

the center of the frame, x (mm). The laser spot should be located at the top of the perpen-
dicular line of the metal frame (as shown in the picture above). If the position is incorrect, 
please contact your reseller.
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CH 5-3 Working Area

4. Move the third reflective mirror : Loosen the nut, use a double head wrench to loosen 
the nut holding the mirror adjustment screw > Adjust the 3 mirror adjustment screws so 
that the third reflective mirror and the triangular mirror holder are parallel and have x (mm) 
spacing (as shown below).

5. Take the honeycomb table out : Move the laser head to the upper right of the working 
range > Press on the “Autofocus” button for 2 seconds to do the Z-axis homing > Lift up 
the honeycomb table handles, hold the two sides of the honeycomb table, and pull it out. 
Please avoid hitting the probe while taking the honeycomb table out.

6. Adjust the third reflective mirror : Refer to the method of "third reflective mirror" and 
adjust the laser spot to the center of the laser outlet again.

7. Move the laser head cover aside : Loosen 2 screws on the laser head cover and then 
   move the cover aside.
8. Paste the tape : Unscrew the nozzle fastening ring and remove the laser head (keep the 

focus lens aside carefully) > Take a piece of double-sided tape and paste it flat on the laser 
head socket, gently press the double-sided tape so that there is a socket indentation on the 
adhesive side of the double-sided tape.

9. Obtain the center laser spot : Move the laser head to the center manually > Close the door
cover > Click “Laser Pulse” > Open the door cover > Observe the spot position and move 
the third reflective mirror as appropriate.

10. Move the third reflective mirror (as shown below) : 
a. The laser spot is in the center of the laser head socket, which means the optical path is  
    vertical and does not need to be adjusted.
b. If the spot is to the right, reduce the parallel gap of the reflective mirror and loosen the 
    3 mirror adjustment screws by half a turn, then repeat steps 6, 8-10 until the spot is in  
    the center of the laser head socket.
c. If the spot is to the left, increase the parallel gap of the reflective mirror and tighten the 
    3 mirror adjustment screws by half a turn, then repeat steps 6, 8-10 until the spot is at    
    the center of the laser head socket.

Note that the focus lens, laser head, and the nozzle fastening ring are installed when obtaining 
the laser spot of the laser head outlet (step 6).
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11. Check the center laser spot : After the adjustment, make sure the laser spots got from the
     laser head socket and from the laser head outlet to the center of the circles.
12. Install the laser head and its cover back : Put the laser head and its cover back > Tighten 
     the 2 screws of the laser head cover.
13. “Calibrate Camera” :  Before using the camera preview function, please first “Calibrate 
     Camera”.【Beam Studio Tutorial】Camera Calibration. (p.059)
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Maintenance Steps : Spray a small amount of alcohol on the acrylic door and clean with a 
cleaning cloth. The amount of alcohol should not be too much to avoid 
cracking the door.

Preparation Items : Self-preparation : 1｜75%~99% alcohol, 2｜Cleaning cloth

Door Cover 
Cleaning

It is recommended to clean 
every 2 weeks.

CH 5-3 Working Area
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The back cover includes the water pump, 
laser tube and ventilation fan.

CH 5-4 
Back Cover



CH 5-4 Back Cover

Laser Tube 
Replacement

Depending on the power, hours of usage, 
room temperature, water temperature 
and other conditions.

1. The degradation of the laser tube. 2. The failure of the laser tube which 
has no laser beam output as well as generates a cracking sound. Laser tube 
are classed as consumables, the degradation is normal due to the use of 
power, storage time and other factors. The higher the power setting, the 
faster the laser tube degradation.

Self-preparation : 5｜Needle nose pliers, 6｜Paper towel or rag, 7｜75%~99% 
alcohol, 17｜Water container, 18 | Scissors, 20｜Vacuum cleaner or high-pressure 
spray gun *If you have one, it is better. 
Included in the accessory box : 1｜Torx screwdriver, 2｜3mm Allen key, 3｜2.5mm 
Allen key, 4｜Double head wrench, 11｜Funnel
Included in the laser tube pack : 8｜Gloves, 9｜Aluminum box, 10｜Conductive 
fabric tape, 12｜Aluminum box screws*2, 13 | Water pipe, 14 | Pipe clip*2, 
15 | Hose connector, 16 | Pipe plug*4, 19 | Laser tube.

Replacement 
Needed : 

Preparation 
Items :

19

11
13 15 16 17

1412

9 10

1 2 3 4 6 7 8

18

5
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1. Please unplug the power cord first, then replace the laser tube.
2. Please use the Torx screwdriver to remove 2 screws on both sides of the 
    back cover and lift the cover.
3. You can remove the dust from the back chassis first and then replace the 

laser tube. Use a vacuum cleaner or high-pressure spray gun to remove the 
dust from the rear chassis, and then use a paper towel or rag with alcohol to 
wipe the dirty area and wait for the chassis to dry before proceeding with 
the next operation.

4. The laser tube has two ends. The high-voltage side is near the screen and the 
low-voltage side is near the reflective mirror.

5. Please put a rag or paper towel on both sides of the high and low voltage to 
avoid damage to the machine due to water seepage.

High-voltage Side Low-voltage Side

Replacement Steps :
1. Disconnect the laser tube wires :

a. Snip & detach: Please wear the provided gloves > Remove the cable wrapper > Snip the
copper part with scissors > Detach the white connector on the high-voltage side > 
(If this is not your first time replacing a tube, please skip this step and remove the
aluminum directly with a 2.5mm Allen key.)

High-voltage side 
white connector

cable wrapper
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Low-voltage Side High-voltage Side

CH 5-4 Back Cover

b. Disconnect the laser tube wires : Press the white terminal and pull out the ground wire >
c. Remove the ground wire on the high-voltage side : Use the 2.5mm Allen Key to loosen 
the screws in the EMI filter. Put out the ground wire connected to the laser tube.

2. Loosen the laser tube holders：Use the 3mm Allen Key to loosen a total of 4 screws on 
the laser tube holders.

Ground wireWhite terminal

Ground wire on 
the laser tube

ScrewEMI filter
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3. Detach the water pipes：
a. Move to the low-voltage side. Push the clamp outward with the Needle nose pliers > 
Remove the hose connector and put it aside for later use > Remove the pipe clip on the 
short hose and set it aside for later use > Make sure that the two water pipe openings 
are inserted into the pipe plug to avoid water leakage.

b. To the high-voltage side, detach the water pipe (the laser tube can move from the tube 
holder seats to the back cover, it will be easier to pull out the pipe) > Insert the pipe plug 
after detaching >

Be sure to put a towel, rag or paper towel under the high-voltage and the 
low-voltage side. Water leakage will cause the machine to malfunction.

Hose connector

pipe clip

pipe plug

pipe plug

Needle nose pliers
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CH 5-4 Back Cover

c. Insert the supplied water pipe and plug it into the water inlet of the laser tube 
to avoid to water leakage > 

4. Remove the laser tube completely.

Avoid contacting the machine parts with water. If water leaks or 
spreads, let the machine dry completely before starting up.

pipe plug
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5. Place the new laser tube and water hose in：
a. Place the laser tube according to the picture >

b. Remove the water pipe plug on the high-voltage side and attach the water pipe to the 
laser tube >

166



CH 5-4 Back Cover

Ground wireWhite terminal

c. Move to the low-voltage side > Remove the pipe plug > Attach the pipe clip to the short-
er water pipe > Insert the hose connector > Use the needle nose pliers to move pipe clips 
towards the connecting side to prevent water leakage.
d. Press down the white terminal and insert the ground wire > Release the white terminal > 
Gently pull the ground wire to check if it is frimly connected.

6. Apply conductive fabric tape, Install aluminum box and Grounding wire connection：

a. Connect the white connector at the high-voltage side and apply the conductive fabric
tape on the laser power supply’s connector >
b. Put the white connector into the aluminum box, mount on the cover and tighten the 
screws with a 2.5mm Allen key. (The box can be put ramdomly in the space as long as the 
cable and wires are not bent or twisted.)
c. Insert the ground wire on the high-voltage side of the laser tube into the screws position 
on the EMI filter > Tighten the screw.

Hose connector
pipe clip

ScrewEMI filter

Aluminum box

Conductive
fabric tape

Laser power 
supply’s connector
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7. Tighten the laser tube holders back :

a. Place the laser tube in position, leaving a finger distance between the tail end, about 
15mm from the laser tube end to the first reflective mirror > Make sure there are no folds 
or kinks of the water hoses >

b. Use the 3mm Allen Key to tighten a total of 4 screws on the laser tube holders > Gently 
shake the laser tube to ensure it will not shift.
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CH 5-4 Back Cover

8. Plug in the power cord and start the machine : After confirming the installation is correct,
    you can plug in the power cord and start the machine.
9. Take out the water pump : Use a Torx screwdriver to loosen 4 screws on the water pump 
    cover > Take out the water pump.

10. Add water : Use the double head wrench to open the water pump cap > Put in the funnel >
Fill the water pump with distilled water > Click “MAINTENANCE” on the screen > Click 
“Pump” after the laser head has finished the X and Y-axis homing. Then the cooling water 
will start to enter the laser tube and the water level of the water pump will drop. Keep add-
ing water until the water pump level reaches 80% full and the water level no longer drops 
due to the adding into the laser tube.

80% full 
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11. Tighten the water pump cap and the water pump cover back：Use the double head
 wrench to tighten the water pump cap back > Place the water pump in its original place > 
Tighten the 4 screws of water pump cover back with the Torx screwdriver.

1.  Make sure there is no folds or kinks of the water hoses to affect the water flow.
2. Please use distilled water to avoid impurities affecting the water-cooling effect.
3. Too many air bubbles inside the laser tube will affect the heat-dissipation 

efficiency. It is recommended to fill the water to more than 80% full or press 
the water hose when adding water, so it is less likely to produce air bubbles.

4. Please observe the water level carefully to avoid overflowing.
5. Please do not touch the area near the high-voltage side of the laser tube after

plugging the power cord in to avoid electric shock.
6. When using the “MAINTENANCE” page, avoid touching the laser switch or 

putting your hand at the laser tube tail end.
7. If the water pump cannot be activated, please contact your reseller.
8. After moving the laser tube, 【Maintenance】Optical Path Alignment (p.146) 

has to be conducted.

Water pump cap
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Water changing 
and adding

Once every 3 months

Notes : In order to avoid the breakage of the glass laser tube due to the heat generated
during laser excitation, it is necessary to maintain the water-cooling effect with 
sufficient distilled water.

Preparation Items : Self-preparation : 1｜Needle nose pliers, 2｜Paper towel or rag, 3｜Water 
container
Included in the accessory box : 4｜Torx screwdriver, 5｜3mm Allen key, 
6｜Double head wrench, 7｜Funnel

CH 5-4 Back Cover

1 2

4 5 6 7

3
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1.  Please turn off the machine and unplug the power cord before changing
    and adding water.
2. Please use the Torx screwdriver to remove the 2 screws on both sides of
    the back cover and then lift the cover.
3. The laser tube has two ends. The high-voltage side is near the screen and 
    the low-voltage side is near the reflective mirror.
4. If the water is not overly dirty, please skip Step 1 and Step 2 as after moving
    the laser tube, the optical path must be realigned.

2. Remove the laser tube holders : Use a 3mm Allen key to loosen a total of 4 screws on the 
    laser tube holders (Photo below) .

Maintenance Steps:

1. Disconnect the laser tube wires :
a. Press the white terminal and pull out the ground wire (Photo above) .

Ground wireWhite terminal
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a. Place towel or paper towel underneath the laser tube in case leakage (Mind the laser 
tube's position and angle) > Move both pipe clips away from the hose connector with the 
needle nose pliers > Remove the joint from one of the hoses and immediately insert the 
hose plug > Repeat the same for the other hose >

b. Drag the longer hose to the bottom side (High-voltage side) of the machine and put 
the opening into the water container > Remove the hose plug to drain water (When the 
water outlet at Low-voltage side is lower than High-voltage side, the water will drain due 
to the Siphon Phenomenon) >
c. Lift the laser tube to drain the water completely. (Skip this step if choosing not to move 
the tube.)

3. Remove laser tube to drain water out：

CH 5-4 Back Cover

Hose connector

Pipe Clip

Pipe Plug
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4. Place the laser tube back and put on the hose：
    a. Place the laser tube in position as the photo above (Skip this step if choosing not to move 
    the laser tube.) >

b. Remove the plug at the High-voltage side and put on the hose.

Avoid contacting the machine parts with water. If water leaks or spreads, 
let the machine dry completely before starting up.
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c. At Low-voltage side. put the clip on the shorter hose > Remove the plug > Insert the joint
on both hoses > Move both clips closer to each other to prevent leakage.

5. Connect the ground wire of the laser tube：
a. To the Low-voltage side > Press down the white terminal and insert the ground wire >
Release the white terminal > Gently pull the ground wire to check if it is firmly connected.

CH 5-4 Back Cover

Ground wireWhite terminal

Hose connector
pipe clip
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6. Fix the laser tube holders : Make sure the distance between the laser tube and the first
    reflective mirror is around 15mm (One finger’s distance)

7. Power cord and start-up : Plug the power cord and turn on the machine.
8. Water pump take out : Remove the back square plate with the Torx screwdriver > Take the
    water pump out.
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9. Water Filling : Open the cap of the pump with double head wrench > Put in the funnel >
Pour the water in > Go to “Maintain Mode” and wait until it finishes homing > Press the 
“Pump” button to turn the water pump > When water tank’s water decreases, pour in more 
eater until the tank is 80% full.

10. Cap and back plate reassembly : Put back the pump’s cap and tighten it firmly with the 
wrench > Place the water pump back in position > Fix the plate back  by tightening these 
4 screws with Trox screwdriver.

CH 5-4 Back Cover

80% Full

water pump cap
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Ventilation Fan 
Cleaning

It is recommended to clean 
once every 1 month.

1 2

Preparation Items : Self-preparation : 1｜Brush, 2｜75%~99% alcohol.

Maintenance Steps : Remove the dust from the ventilation fan with a brush, then wipe the
                                  ventilation fan blades with alcohol.

Please check【Unboxing】(p.29) for the position of ventilation fan.

178







Trouble-
shooting

CH 6



CH 6-1
Trouble-
shooting

This manual classifies the issues into three categories 
according to their contents, including hardware, soft-
ware, and comprehensive issues. The test items and 
solutions for each problem are explained here in order.

FLUX > “Supports” > “Help Center” has more resources to help users with 
easy troubleshooting. If you cannot follow the guides from this manual or Help 
Center, you need to collect relevant information (troubleshooting records) and 
contact your reseller. *Please refer to 6-5 for the troubleshooting records and 
contact your reseller with all the items in order to solve the problem faster.



CH 6-1 Troubleshooting

#900p.185

p.187

p.189

p.1 9 1

p.1 9 8

p.200

p.201

p.206

p.1 97

p.1 9 6

p.192

p.1 93

p.1 94

p.1 95

p.209

p.209

p.2 1 1

p.2 18

p.220

p.220

p.22 1

p.222

#901

#902

#9 1 1

#912

#913

#910

#904

Cooler Off Water hose, water pump, 
flow sensor

Door Opened Door cover sensor magnet, 
magnetic reed switch

Overheated 

Homing Failed

Room temperature, water 
temperature, water pump

Material cannot 
be cut through

Focusing, power on the screen, 
reflective mirrors and focus lens, 
optical path, laser tube

Do the homing, height adjustment 
button, Z-axis bottom limit switch

No Laser Beam Output Laser tube

Mirrors and lens are 
oxidized or broken

Reflective mirrors and focus lens

Z-axis top limit switch, probe

Drawer sensor magnet, magnetic 
reed switch

Air flow beneath the laser outlet, 
air hose, T joint

Click “MAINTENANCE” on the 
screen to home the X and Y-axis

Minor electric shocks 
from chassis

Unresponsible motorized 
work table

Abnormal Fire Detection

Abnormal Z-axis 
top limit switch

Drawer Opened

Z-axis Homing Failed

Abnormal Air 
Flow Detection

-

height adjustment button

-

Connection Issue MAC Address, IP address, 
“Test Network Settings”

Unable to Open 
Software Properly

Windows : Visual C++ 
Redistributable / macOS : Version

Camera preview screen 
stitching is inaccurate, 
Actual engraving position 
is different from camera 
preview position

Focus plane, camera calibration, 
SVG file

Other Software Error Codes -

Camera preview speed is 
too slow

Camera preview screen is 
overexposed

Camera Preview Timeout 
or Failed to Connect

Camera preview screen is 
blurry

“Camera” in the MAINTENANCE 
page 

Camera lens

Wi-Fi dongle, network 
environment

Ambient lighting

Issue Category Issue Content (Error Code) Test Items

Hardware

Software

Comprehensive
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Hardware 
Issues



1 2

4

6

3

5 7

CH 6-2 Hardware Issues

Cooler Off
#900 Lift the cover after removing the 2 

screws on both sides of the back cover 
with a Torx screwdriver.

Preparation Items : Self-preparation : 1｜Distilled water, 2｜Water container, 3｜Cable tie, 
4｜Diagonal pliers
Included in the accessory box: 5｜Torx screwdriver, 6｜Double head 
wrench, 7｜Funnel
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Water pump

Air bubble inside 
the laser tube

Test Items:

1.  Click “Resume” button : Try to continue working, if no error message appears again within one 
    minute, then it can be used normally.
2. No folds or kinks of the water hose : If the water hose is obviously creased, press the area back 
    to the cylinder shape > Use the cable tie to fix the position.
3. The water pump should be at least 80% full : If the water level in the water pump does not 

reach 80% full, water must be added【Maintenance】 Water changing and adding. (p.171) > 
Press the water hose to discharge the air bubbles inside the laser tube as many as possible.

4. Test the flow sensor : Test the flow speed, which should be above 3.0L/min : Machine screen >
 “MACHINE” > “Hardware Settings” > “Test Flow Speed”.

5. Replace the cooling water : If you have tried steps 1 ~ 4 and still have an error, please replace 
the cooling water【Maintenance】Water changing and adding. (p.171). It would be helpful if 
you can record a video at the same time.

Troubleshooting Records:

1. Photo : Machine screen > “MAINTENANCE” > Turn on the “Pump” and take pictures of :
a. Water hose (bending at the connection)
b. Laser tube (the number of bubbles and flowability)
c. Water pump (water volume, water pump blue light should be constantly on)
d. Flow sensor (reading), as the right figure.

2. Video : The video of cooling water replacement should include the content of photos
(water hose, laser tube, water pump, flow sensor) to ensure that the above components 
are working properly.
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CH 6-2 Hardware Issues

Door Opened
#901

Preparation Items : Self-preparation : 1｜Super glue
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Test Items:

1. Check the door cover sensor magnet : If the door cover sensor magnet is off but not lost,
you can point super glue at the magnet base to glue the magnet back. If the magnet is 
lost, please contact your reseller.

2. Test the magnetic reed switch : Open and close the door cover continuously, observe 
whether the 2 indicator lights are obviously on and whether the door cover symbol is 
displayed normally in the upper right corner.

Troubleshooting Records :

1. Photo :
a. Magnet (whether it is off)	
b. Magnetic reed switch indicator lights (whether 
they are obviously on)

2. Video : Need to include the action of opening and
closing the door cover and the change of the door 
cover symbol.

Door cover 
opened

Door cover 
closed

Magnetic reed switch 
indicator light

Door cover 
sensor magnet
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1 2

43

CH 6-2 Hardware Issues

Overheated
#902

Preparation Items : Self-preparation : 1｜Distilled water
Included in the accessory box: 2｜Funnel, 3｜Double head wrench, 
4｜Torx screwdriver

Overheated warning temperature can be adjusted in 
"MACHINE" > "Hardware Settings" > "Water Temperature 
Threshold".
High water temperature will degrade the laser tube faster, 
so it is recommended to prevent the overheated warning 
by decreasing the room temperature instead of increasing 
the water temperature threshold.
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Test Items:

1.  Room temperature should not be too high :
 a. Keep the right side of the machine heat vent open and should not shade the bottom air 
 intake.
 b. Room temperature above 30°C is not suitable for the use of CO2 laser.

2. Water temperature should not be too high : The water temperature should be between 
     5°C-30°C.

The starting temperature of water is low, or the machine has good heat dissipation ability, 
the continuous cutting time can be longer.

3. Reduce the high-power operation time :
a. If the water temperature is too high due to continuous cutting, you should wait for the 
machine to dissipate heat and the water temperature to decrease before clicking “Resume” 
for operation. This will not affect the engraving result. A suitable pause in cutting will help 
to improve the heat dissipation and can effectively increase the continuous cutting time.
b. Arrange engraving works between the cutting jobs so that the laser tube can have enough 
time to dissipate heat.

4. The water pump should be at least 80% full : More water will make the water temperature 
rise more slowly. If the water level in the water pump is less than 80% full, water should be 
added【Maintenance】 Water changing and adding. (p.171) > Press the water hose to dis-
charge the air bubbles inside the laser tube as many as possible. The water-cooling system 
of this model is a closed water circuit, if the water pump cap is covered, general use will not 
cause water evaporation, the water level of the water pump drops, if the water level decreas-
es significantly within a week, please contact your reseller. 

Water cooling fan

Screw hole

Troubleshooting Records :

1. Photo : Flow speed reading (should be greater than 
3.0 L/min) (“MACHINE” > “Hardware Settings” > “Test 
Flow Speed”)

5. Water cooling fans work normally : Loosen the 8 screws on the side cover with a Torx  screw-
driver and move the cover aside > Press the “MAINTENANCE” on the machine screen > Click 
“Pump”. After the water pump is turned on, you can check whether the 3 water cooling fans 
are working.
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Homing 
Failed

#904

Troubleshooting Records :

1. Video : The complete X and Y-axis homing process should be recorded. The screen should
cover the whole machine. When the X and Y-axis homing process starts, focus on recording 
the screen and sound at the top left of the machine. Manually pull the laser head to the 
center of the working range > click “MAINTENANCE” on the screen, then the laser head will 
move up to the top and then move left to the far left to complete the X and Y-axis homing. 
As shown in the picture.

Since the reason for "#904 Homing Error" is 
rather complicated, please provide the trouble-
shooting video to your reseller directly.

CH 6-2 Hardware Issues
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Z-axis Homing 
Failed

#910 Since the reason for "#910 Z-axis Homing 
Error" is rather complicated, please provide 
the troubleshooting video to your reseller 
directly.

Z-axis bottom limit 
switch: triggered

Z-axis bottom limit 
switch: not triggered

Test Items : 

1.  Test the height adjustment buttons : Press 3 buttons in turn to make sure the motion 
    along Z-axis is normal.
2. Test the Z-axis bottom limit switch : Take the honeycomb table out【Maintenance】

Honeycomb Table Cleaning, step 1 (p.135) > Click “MAINTENANCE” on the screen > Press 
the Z-axis bottom limit switch, and observe the change of its symbol from the screen.

Troubleshooting Records :

a. The complete homing process should be recorded. (Press on the “Autofocus” button for 
2 seconds to do the Z-axis homing.) Focus on recording the motion of Z-axis motor and its 
sound.
b. Height adjustment buttons (whether they are functional)
c. Z-axis bottom limit switch (whether the symbol is shown correctly)

Height adjustment 
buttons

Z-axis bottom 
limit switch

Z-axis motor

192



Drawer Opened
#911

Preparation Items：Self-prepartion：1｜Super glue, 2｜Magnet

1 2

CH 6-2 Hardware Issues

193



Test Items：

1. Check the drawer sensor magnet：After opening the drawer, check if the drawer sensor
magnet on the front of the drawer is over there. If the magnet on the drawer is off but not lost, 
you can glue the magnet back. If the magnet is lost, please contact your reseller. Remove the 
honeycomb table【Maintenance】Honeycomb Table Cleaning, step 1. (p.135) first, and push 
the drawer out from the inside of the chassis will be easier to open the drawer.

2. Test the magnetic reed switch：Open the drawer > Click “MAINTENANCE” on the screen > 
Take another magnet to cover the magnetic reed switch > Observe the change of the drawer 
symbol.

Troubleshooting Records：

1.  Photo：Drawer sensor magnet (whether it is off)
2. Video：Test the magnetic reed switch, including the use of external magnet, and the
    change of the drawer symbol.

Abnormal Fire Detection

The machine is in use, and (1) there is no flame generated, but the buzzer is making a buzzing 
sound, or (2) there is a fire, but the buzzer is malfunctioning. Both situations indicate that 
parts could be problematic. Please stop using the machine and contact your reseller. Repair 
parts as soon as possible to keep the warning function works.

#912

Magnetic reed switch

Drawer sensor 
magnet

Drawer opened Drawer closed
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Troubleshooting Records：

1.  Photo：
a. Air hose (bending at the connection)
b. T joint (connections)

2. Video：Record the air flow change at the laser outlet before and after turning on the air 
    pump.

T joint

Abnormal Air Flow Detection
#913

Test Items：

1. Check the air flow at the laser outlet (air pump)：Click “Air pump” on the screen >
Place a piece of paper at the laser outlet and test whether the laser head is blowing air 
normally.【Maintenance】MAINTENANCE Page：Function Test, Switches – Air Pump. 
(p.127)

2. No folds or damages of the air hose：If the air hose is obviously creased, press the
area back to the cylinder shape. If the air hose is worn to cause a leak, please contact 
your reseller.

3. Check the T joint：Loosen the 8 screws on the side cover with a Torx screwdriver
and move the cover aside > Make sure the air hoses on the T joint are installed firmly.

Preparation Items：Self-prepartion：1｜Paper

CH 6-2 Hardware Issues
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Abnormal Z-axis top limit switch

Test Items：

1. Test the Z-axis top limit switch：Take the honeycomb table out【Maintenance】Honeycomb
Table Cleaning, step 1 (p.135) > Click “MAINTENANCE” on the screen > Use a long tool such 
as a pen to press the Z-axis top limit switch, and observe the change of its symbol from the 
screen.

2. Check the probe：Double click the “Autofocus” button to do the focusing. When the motor-
ized work table is rising, kindly tap the probe. Then, check if the probe retracts and the table 
stops moving.

Troubleshooting Records：

1. Video：
a. Z-axis top limit switch (whether the symbol is shown correctly)
b. Probe (whether it is functional)

Z-axis top limit 
switch: triggered

Z-axis top limit 
switch: not triggered

Height adjustment 
buttons

Z-axis top
limit switch
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Troubleshooting Records：

1. Video：Press 3 height adjustment buttons in turn.

Unresponsible motorized work table

CH 6-2 Hardware Issues
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First reflective mirror

Second
reflective
mirror

Third
reflective
mirror

Focus lens

Top right

Middle rightMiddle left Center

Bottom rightBottom left

Top left

X-axis

Y-axis

Z-axis

Material cannot 
be cut through

Self-Preparation Items: As 
described in the Test Items.

Test Items :

1. Make sure the focus is correct : Double click the “Autofocus” button to allow the motorized 
work table to rise and let the probe automatically touch the surface of the engraving materi-
al. The distance between the laser head and the surface of the engraving material should be 
12mm±1mm.

2. Check the screen power setting : The power on screen is preset to x1.00. If the software 
power and the screen power are multiplied by less than 15%, it is possible that there is no 
laser beam output.

3. Make sure the mirrors and lens are clean and undamaged : Clean the reflective mirrors and
    focus lens, please refer to【Maintenance】Mirrors and Lens Cleaning (p.138).
4. Make sure the optical path is not misaligned :

a. Put the double-sided tape on the first reflective mirror > Make sure the laser spot is on the 
first reflective mirror.
b. Apply the double-sided tape to the second reflective mirror > Make sure the bottom left 
and top left laser spots overlap.
c. Apply the double-sided tape to the third reflective mirror > Make sure the middle right and 
middle left laser spots coincide.
d. Apply the double-sided tape to the laser outlet > make sure the laser spot is in the center.
If the above conditions cannot be met, it means the optical path is misaligned and needs to 
be aligned【Maintenance】Optical Path Alignment (p.146).

5. Confirm that the laser tube is not degrading : If you have confirmed 1~4 items but still cannot
    cut the engraving material, please contact your reseller.
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First reflective 
mirror

Second reflective 
mirror

Third reflective 
mirror

CH 6-2 Hardware Issues

Troubleshooting Records :

1. Photo : Take pictures of
a. 3 reflective mirrors (whether there are stains)
b. Focus lens (whether there are stains)

c. Double-sided tapes on 3 reflective mirrors after optical path alignment (shapes and 
colors of laser spots) Please stick the tapes as below, and press the “Laser Pulse” twice.

Focus lensReflective mirror
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No Laser Beam Output

Test Items :

1. Stop using the machine when there is an abnormal sound : If the laser outlet does not show 
light and the laser tube makes a "cracking" sound during the use of the machine, it means that 
the laser tube is malfunctioning, please stop using it immediately to avoid overloading the 
power supply and causing damage to other parts.

2. Observe whether there is light in the laser tube : If there is no obvious noise but still no laser
beam comes out, please observe whether there is a light from the laser tube. Go to the “MAIN-
TENANCE” page > Make sure the power setting is x 1.00 > Close the door cover > Click on 
“Laser Pulse” > At the moment of clicking, you should see a pinkish fluorescent light instantly 
from the laser tube observation hole. If there is fluorescence, it means the laser is operating 
normally, please refer to【Maintenance】Optical Path Alignment (p.146). If there is no fluores-
cence, please contact your reseller.

Troubleshooting Records :

1.  Video : Record the laser tube observation hole status at the moment of pressing “Laser Pulse”
    (whether there is pinkish fluorescence).
2. Photo : If there is pink fluorescence, please provide double-sided tapes on 3 reflective mirrors 
    after optical path alignment (shapes and colors of laser spots).

Laser tube shows a pinkish 
fluorescent light
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Mirrors and lens are oxidized or broken

1 2

CH 6-2 Hardware Issues

Preparation Items : Self-Preparation : 1｜Needle nose pliers
Included in the accessory box : 2｜Torx screwdriver
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First reflective mirror

Second
reflective
mirror

Third
reflective
mirror

Focus lens

Oxidized reflective 
mirrors

Test Items :

1. Check if mirrors and lens are oxidized or broken : If there are black spots, white spots, etc. 
on the surface of the first, second, and third reflective mirror, or if there are serious scratch-
es, and the stains cannot be removed by【Maintenance】Mirrors and Lens Cleaning (p.138), 
or if the focus lens is deformed or broken due to external force, the mirrors and lens should 
be replaced.

Replacement Steps :

First reflective mirror :
a. Lift the back cover: Please use a Torx screwdriver to remove the 2 screws on both sides of 
the back cover and then lift the cover.
b. Loosen the aluminum cover: Loosen the aluminum cover that fixes the mirror (face the 
mirror and turn counterclockwise), if it cannot be turned, use needle nose pliers to clamp the 
aluminum frame and turn again >
c. Replace the mirror: Take out the old mirror > Put the new mirror with the matte side facing 
the mirror holder (laser beam will hit the shiny side) > 
d. Tighten the aluminum cover: Tighten the aluminum cover back to the mirror holder.

Matte side

Shiny side

Aluminum cover
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Second reflective mirror : After opening the door cover, follow the first reflective mirror steps 
b~d (the position of the second reflective mirror is indicated in the picture in p.202).

Third reflective mirror : 
a. Loosen the fixing cap: Use the needle nose pliers to hold the two round points of the fixing 
cap of the mirror, and unscrew the fixing cap counterclockwise > 
b. Replace the mirror: Take out the old mirror, you can pull out the mirror from the laser inlet 
area > Place the new mirror with the shiny side facing the mirror holder > 
c. Tighten the fixed cap: Use needle nose pliers to hold the two round points of the fixing cap 
of the mirror, and tighten the fixing cap clockwise.

Fixing cap
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Laser head cover

Screw

Focus lens:
a. Remove the honeycomb table【Maintenance】Honeycomb Table Cleaning, step 1 (p.135). >

b. Move the laser head cover aside : Loosen 2 screws on the laser head cover with a Torx 
screwdriver and then move the cover aside >
c. Remove the laser head：Unscrew the nozzle fastening ring clockwise. If it cannot be 
unscrewed, use needle nose pliers to assist > Remove the laser head, and please avoid the 
focus lens from being popped out >

204



CH 6-2 Hardware Issues

d. Replace the lens : Remove the old lens > Put the new lens into the laser head with the flat 
side downward (hold the edge of the lens and look into the lens, you can see yourself on the 
convex side, but you cannot see yourself on the flat side) >
e. Put the laser head back : Put the laser head back > Tighten the nozzle fastening ring coun-
terclockwise >
f. Tighten the laser head cover : Tighten 2 screws on the laser head cover > 
g. Put the honeycomb table back 【Maintenance】 Honeycomb Table Cleaning, step 3 (p.135).

Troubleshooting Records :

1. Photo : Take pictures of
a. 3 reflective mirrors (whether oxidized)
b. Focus lens (whether oxidized or broken)

Flat sideConvex side

Focus lensReflective mirror	
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Minor electric shocks from chassis

Preparation Items : Self-preparation : 1｜Phillips screwdriver, 2｜Ground wire, 
                                3｜3-prong adapter

Everyone's sensitivity to electric current is different, that is, everyone will have different de-
grees of feelings about leakage. Due to the design mechanism of the laser tube, there will 
be a slight controlled leakage current for the tube to function properly, which is a normal 
phenomenon, do not worry too much. The laser cutting machine must be properly grounded 
while using. If it is properly grounded, there will be no leakage. If you touch the machine when 
it is operating, and you may feel a minor electric shock, it maybe the 3-prong outlet is not 
properly grounded, or the third prong is not fully grounded.

Solution :

1. DIY grounding : Connect the 
machine's power cord to a 3-prong 
adapter > Connect the adapter's 
ground terminal to the building's 
metal piping to achieve an approxi-
mate grounding effect.
2. Wear shoes to use the machine : 
Avoid using the machine with bare 
feet, wearing shoes can reduce the 
risk of electric shock.
3. Plug the adapter into the outlet 
reversely : If you are unable to DIY, 
connect the power cord to the 
3-prong adapter and plug it into 
the outlet in the opposite direction 
(rotate 180 degrees).
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                                3｜3-prong adapter
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Windows
If your computer pops up a not responding window when you open the software, please 
make sure you have installed Visual C++ Redistributable on your computer.
Please install Visual C++ redistributable packages for Visual Studio 2015, 2017 and 2019.

macOS
Please update your system to macOS 10.14 (Mojave) or above. Some older versions of macOS 
may have support issues.

Steps to Follow :

1. Record :
a. Record the current software and firmware versions.
b. Explain the operation behavior (or recording) and take screenshots.

2. Export a bug report : Export a bug report when an error message pops up. 
(Menu > “Help” > “Bug Report”)

3. Retry: Reopen the software > Retry the behavior.
4. Check the Help Center : Go to official website “Supports” > “Help Center” to 

search for solutions. (https://support.flux3dp.com/hc/en-us)
5. Update software and firmware : Update software and firmware to the latest beta 

version > Retry the behavior.
6. Record again : As in step 1.
7. Export another bug report : As in step 2.

Troubleshooting Records : 

1. The information collected in steps 1, 2, 6, and 7.
2. .beam files and image files, etc.

When the software is abnormal, error messages will pop up in your computer window. If you 
are unable to follow the steps below to resolve the software issues, please contact your reseller.

Unable to Open Software Properly

Other Software Error Codes

CH 6-3 Software Issues
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CH 6-4 Comprehensive Issues

Connection 
Issue

Make sure that the MAC Address in the "NETWORK" 
of the machine screen has a value, IP address starts 
with 192.168 and the network quality is good so that 
you can have a stable connection.

Preparation Items : Self-preparation : 1｜Ethernet cable (Wired Network*1 or 2, Direct
                                 Connection*1) 

Included in the accessory box: 2｜USB cable, 3｜Wi-Fi dongle
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Test Items :
1-1. There is a value for MAC Address in the "NETWORK" page :

a. Wi-Fi :
- Built In Wi-Fi:

Click “NETWORK” on the machine screen > Check whether MAC Address 
under Embedded Wireless Network has a value, as shown below. If there is a 
value, then please go directly to the 2nd test item. If there is no value, please 
insert the Wi-Fi dongle and look the Extender Wi-Fi below.

- Extender Wi-Fi:
Screw the Wi-Fi dongle firmly > Fold the dongle antenna up 90 degrees and 
insert it into any USB socket on the side of the machine > Click “NETWORK” 
on the machine screen > Check whether MAC Address under Extender Wire-
less Network has a value, as shown below. If there is a value, then please go 
directly to the 2nd test item. If there is no value, please insert the Wi-Fi don-
gle into another USB socket for use. If neither socket shows the MAC address, 
please contact your reseller.

b. Wired Network : (machine - router – computer, take 2 ethernet cables as an 
example):
One RJ45 ethernet cable connects the machine to the router and the other 
RJ45 ethernet cable connects the router to the computer > Click "NETWORK" 
on the machine screen > Verify that MAC Address under Wired Network has a 
value, as shown below. If there is a value, please go directly to the 3rd test item. 
If there is no value, please try to replace the network cable or contact your 
reseller.

c. Direct Connection (machine-computer) :
A RJ45 ethernet cable is connected to the machine and the computer on both 
ends > Enable Internet connection sharing【Connection Settings】2-5.4 Direct 
Connection (p.053), Windows setting as 1, c, macOS setting as 2, c~e > Click 
"NETWORK" on the machine screen > Check if the MAC Address under Wired 
Network has a value, as shown below. If there is a value, then you can go directly 
to the 3rd test item. If there is no value, please try to change the network cable 
or contact your reseller.
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1.2. Network status is "Connected"：

CH 6-4 Comprehensive Issues

USB Connection (machine~computer)：
A USB cable is connected to the machine USB-B slot and the USB adapter on 
both ends. Install the USB-C of the adapter to the computer. > Verify that the 
network status is "Connected."【Connection Settings】CH2-5, 3. USB Con-
nection (p.051)，Windows setting as 1-b., macOS setting as 2-b., as below. If it 
shows "Connected", please go directly to the 5th test item. If it does not show 
"Connected", please try to replace the USB cable or contact your reseller.

2. "Connect to WiFi": ”Connect to WiFi" > Select the Wi-Fi you want to use > Enter the Wi-Fi 
     password and press “Confirm”.

a. If the Wi-Fi name is not displayed :
Make sure the Wi-Fi channel is 2.4Ghz, the machine does not support 5Ghz.
b. If Wi-Fi name is displayed, but you cannot connect to it :
Check the Wi-Fi encryption type, it should be WPA2 or None (no password). The encryp-
tion type can be set by your computer, but be aware that not all routers support WPA2.
c. Unable to connect to iPhone hotspot :
Make sure the phone hotspot name should not have special characters or non-English 
characters. If the phone system is iOS 13, keep the hotspot page open when the machine 
connects to the hotspot; if the connection fails, turn off the hotspot for about 10 seconds, 
then reopen the hotspot and try to connect again.
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3. Confirm the beginning of IP address :

4. Fill the IP address of machine in Beam Studio: Fill the IP address starting with 192.168 in
    the software.

5. Test the connection stability : If the software still cannot find the machine after filling the
    IP into the software, please confirm the connection stability.

a. Menu > "Machines" > "Test Network Settings" > 

a. Windows :
Menu > “File” > “Preferences” > Machine IP Address > Apply.
b. macOS :
“Beam Studio" > "Preferences" > Machine IP Address > Apply.
c. Linux :
“Beam Studio” > “Preferences” > Machine IP Address > Apply.

a. Wi-Fi :
Make sure the "Wireless IP" of the machine starts with 192.168.
b. Wired Network :
Verify that the "Ethernet IP" of the machine starts with 192.168.
c. Direct Connection :
Verify that the "Ethernet IP" of the machine starts with 192.168.
d. If the IP address starts with 169.254 :
If the IP address starts with 169.254, it means that the network interface card did not 
obtain the IP address automatically. And usually this is because the router does not have 
DHCP service enabled or the DHCP service is malfunctioning. Please contact your internet 
service provider to turn the DHCP function on.

If you have other connection problems, please refer to “FLUX > Supports > 
Help Center > Beam Studio > Connection” for other instructions.
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b. Fill in the IP of the machine you want to use in "Target device IP address" > "Start" > (If 
USB Connection is used, and the operating system is Windows, machine IP or so-called 
Target device IP address should be 10.55.0.17. If the system is macOS, Target device IP 
address should be 10.55.0.1.)

c. The test data includes Connection Quality and Average Response Time >

After Beam Studio version 1.4.2, Connection Quality > 70 and Average Response Time < 100ms 
means the connection is stable. If the connection is stable but the software cannot find the 
machine, please update the software and fill in the IP in “Preferences” > Machine IP Address. If 
the connection is not stable, please check the Wi-Fi signal strength and whether the computer 
and the machine are using the same network.
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Troubleshooting Records :

1. Photo : 
(1)  If any of Wi-Fi, Wired Network, or Direct Connection is used, connect the Built In Wi-Fi,

Wi-Fi dongle or ethernet cable > Turn on the machine > Click “NETWORK” and take 
pictures of  :
a. Antenna (connector, angle) or etherne port
b. Wireless Network MAC Address, Wired Network MAC Address
c. Wireless IP, Ethernet IP
d. Screenshot of the result of “Test Network Settings”

Dongle antenna

Ethernet port

Antenna
connector
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(2) If USB Connection is used, connect the USB cable > Turn on the machine and take   
      pictures of :

a. Network status (whether it is connected)
b. Screenshot of the result of "Test Network Setting"

CH 6-4 Comprehensive Issues

217



Result of wrong focus

Result of correct focus

Accurate focus and calibration can make the preview picture stitching more accurate and 
make the engraving position consistent with the preview position.

Camera preview screen stitching is inaccurate, 
Actual engraing position is different from camera 
preview position

Test Items :

1. Confirm the correct plane of focus :
Double click the “Autofocus” button to allow the motorized work table to rise and let the 
probe automatically touch the surface of the engraving material. Every time you change the 
material of different thickness, you need to lower down the work table and do the autofocus 
again to ensure the correct focus. When engraving, if the focus is not correct, the laser beam 
will be thicker than the laser beam with correct focus.
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Troubleshooting Records :

1. Image file : If there is still a discrepancy between the result and the preview position after 
using SVG file and confirming the correct plane of focus and accurate camera calibration, 
please provide the SVG file to the your reseller and let the engineering team assist.

Thicker object : When the object is thicker or when the rotary add-on is used, the side of the 
object may be captured by the camera, and only the objects on the plane of focus can be 
stitched together, and the picture out of focus and inaccurate stitching caused by the height 
difference is normal. Be sure to focus on the surface of the engraving material and the highest 
point of the engraving material when using the rotary add-on.

2. Complete camera calibration (left of below pictures) :
After exposing to shock and vibration of transportation, optical path alignment, and Reset 
to Factory, etc., all need to be recalibrated. The calibration steps are as described in【Beam 
Studio Tutorial】Step 2 (p.057).
There are two calibration objectives:
a. The red square must be located in the center of the calibration window.
b. The outside of the red square must be aligned with the center square of the grid lines.

3. Confirm the calibration result (right of below pictures) : Draw a square at (X,Y) = (77.5mm, 
77.5mm) with a width W and height H of 25mm and make sure the square overlaps with 
the center square of the grid lines. If it does not fit, refocus the paper and recalibrate the 
camera.

CH 6-4 Comprehensive Issues

25mm

25mm

(X,Y) = (77.5mm, 77.5mm)
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Troubleshooting Records : The reason for not 
being able to use the camera may be related 
to hardware or software, so please directly 
provide the troubleshooting video to your 
reseller for evaluation.

1. Video : The screen should cover the whole
machine, focusing on recording the machine 
screen. Click "MAINTENANCE" > "Motors" 
> "Camera" > Open the door cover > Slow-
ly move the laser head around the working 
range for 3 rounds and observe whether 
there is a picture on the screen, as shown 
in the picture, if the picture is white, please 
contact your reseller. (Note that the camera 
updates the screen every 3 seconds.)

Camera Preview Timeout or Failed to Connect

Test Items :

1.  Wi-Fi dongle is not loose : Make sure the Wi-Fi dongle at the back of the machine is not  
    loose, and the antenna connector has been tightened.
2. Shorten the distance between the machine and the hotspot : Shorten the distance 

between the machine and the wireless network source (router or hotspot), or try to use 
wired connection. If the above items do not solve the problem of slow camera preview 
speed, please refer to "Camera Preview Timeout or Failed to Connect" or contact your 
reseller.

Camera preview speed is too slow
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Camera preview screen is blurry

Preparation Items : Self-preparation : 1｜Cotton swab, 2｜75%~99% alcohol

Test Items :

1. Check the cleanliness of the camera lens : Click "MAINTENANCE" on the screen >
   "Camera" > check the cleanliness of the lens from the screen panel.
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Operation Steps :

1.  Clean the camera lens : Use a cotton swab with a small amount of alcohol to clean the
    camera lens > Then use a dry cotton swab to dry the lens.
2. Confirm the camera screen :

a. Click "MAINTENANCE" > "Camera" > confirm the lens is clean from the screen panel.
b. Use the software Beam Studio camera preview function to confirm that the camera 
preview screen is clean.

Camera preview screen is overexposed

Preparation Items : Self-preparation : 1. dark fabric or cardboard.

Test Items :

1. Confirm that the environment is free of strong light interference :
a. Check that there is no strong light above the machine, such as track lights, flurescent 
lamps, etc. 
b. Make sure the machine is not placed in a place in harsh sunlight.

Operation Steps :

1. Remove or shield the strong light source :
a. Cover the acrylic door cover above the engraving material with a dark fabric or cardboard.
b. Turn off the indoor light source above the machine.

2. Retry the camera preview : Make sure that the camera preview screen is back to normal.

Camera lens
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 6-5 Contact Customer Service

FLUX > “Supports” > “Help Center” has more resources to help users with easy 
troubleshooting. If you are unable to troubleshoot a problem according to this 
manual or Help Center, please provide the following items to your reseller.

The following information is subject to actual use :

Contact your reseller to get a prompt support!
Contact  FLUX :
Private message to Facebook fan page : https://www.facebook.com/flux3dp/
email : support@flux3dp.com
 

Name :
Telephone :
email :
Address :
Purchasing platform : For non-FLUX official website purchasers, please provide a 

photo of the order details.
Operating system : Windows / macOS / Linux
Software version : Windows: Menu > “Help” > “About Beam Studio”.

macOS: Menu > “Beam Studio” > "About Beam Studio”.
Browser: Chrome / Safari.
(Supported devices for browser version are those with either viewport 
width or height is over 1024 pixels.)

Firmware version : Machine screen, “MACHINE” > Firmware Version.
Laser tube usage hours : Machine screen, “MACHINE” > Laser Tube Usage.
Machine serial number : Please provide a photo of the sticker on the back of the machine.
Troubleshooting Records : Please provide photos or videos according to the Troubleshooting
                                             Records in this chapter.

Help Center
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Warranty Period

Warranty period starts at the time of customer receives the product. Please see the chart 
below for the warranty periods.

CH 7 Warranty

4. During the product’s warranty period, FLUX may, at its discretion, take one or more of the
following actions: (1) send parts to customer along with tutorials for repair, (2) approved 
return of the product to an authorized local reseller for (i) repair with new or refurbished 
parts or (ii) replacement with a new or refurbished product provided that:
- The product was properly used according to the manufacturer’s intended purposes and 
instructions.
- The product was not damaged due to acts of nature such as lightning, flood, or fire.
- The product’s casing was never disassembled without permission.
*Note : Particles, scratches, unevenness, or other appearance issues which do not affect 
the function of the machine are not covered under the warranty. 

5.  Under the specified warranty period, our authorized local reseller may recall and repair 
your products and absorb the local shipping fee (international shipping is not included) 
without charging you.

Hardware Warranty

1.  FLUX Inc. warrants only the hardware (excluding accessories and consumable parts*)
against defects in materials and workmanship when used as instructed in the manual for 
the warranty period.
*Consumable parts include reflective mirrors, focus lenses, and vent hoses.

2. The limited warranty covers products purchased from authorized FLUX retailers against
defects in materials or workmanship.

3. Customers must provide the machine serial number and related information as proof of
    purchase. 

*Prior to returning any products, customers must receive an approval of shipping from 
our authorized reseller via email or phone. We will not accept any unapproved re- turned 
goods

Product Warranty Period

12 months

12 months

12 months

HEXA (Laser Tubes excluded)

60W Laser Tube

Rotary / Beam Air

Post Warranty Support and Repair

1.  FLUX will continue to provide tech support via phone, email, and other online methods
    even after the product warranty period.
2. After the warranty period, all costs—including but not limited to replacement parts, 
    shipping charges, and testing fees—are the sole responsibility of the customer.
3. Our authorized reseller may provide a quote for repairs.

v2021.12
As a FLUX consumer, you benefit under certain conditions from additional warranties. 
FLUX offers specific consumer warranty benefits which are in addition to, and not 
instead of, any legal warranties provided by your national consumer law. The duration 
and conditions related to the legal warranties are provided by respective local laws.
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CH 8 Disclaimer

Disclaimer
 
1. FLUX Inc. does not warrant against normal wear and tear, items consumed or expended
   by normal use, product misuse, or accidental damage. 

2. FLUX is not liable under this warranty for any damages or defects caused by :
(1) Improper (contrary to the stated purpose and scope of use described in relevant 
     documentation) use of Products or Add-ons;
(2) External force;
(3) External or internal inside;
(4) Lightning strike, overvoltage, power surge, or electromagnetic field.
(5) Unauthorized change, correction, or modification. Modification of the hardware or 

accessories, including but not limited to replacing parts, making permanent cosmetic 
changes to the machine, replacing the software or firmware, or other unauthorized 
changes voids this warranty policy.

(6) Natural or human-caused calamities such as earthquake, war, fire, and flood.
(7)  Improper storage, operation, application, or transportation.
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Appendix 1



With the use of different Add-on combina-
tion, the engraving materials can be diver-
sified.

Appendix 1-1

Add-on 
Introduction



Beam Air

Note: Add-ons may not be available for specific regions / countries.

HEXA 1.5 inch 
Focus Lens

Finer laser spots

Dust, tar and odor filtering

Appendix 1-1 Add-on Introduction

Rotary
Cylindrical object engraving
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Appendix 2-1

Design
Software
Recommenda-
tions



Adobe
Illustrator

Affinity
Design

Sketch

SolidWorks

Rhinoceros

Vector graphics editor by Adobe Inc.

3D computer graphics and CAD applica-
tion, abbreviated Rhino3D

Solid modeling CAD for Windows by 
SolidWorks

Vector graphics editor by Corel Corporation

Vector graphics editor for macOS by 
Sketch B.V.

3D modeling program for architects, urban 
planners, filmmakers, game developers, and 
related professionals

Vector graphics editor for Windows and 
macOS by Serif Ltd

Computer-aided design (CAD) and drafting 
software application by Autodesk, Inc.

Raster graphics editor by Adobe Inc.

Beam Studio supports the follow-
ing file formats :
SVG / PNG / JPG / DXF / PDF / AI
Version Support : 
Beam Studio supported operating 
system versions

Adobe
Photoshop

Autodesk
AutoCAD

SketchUp

Corel Draw

Appendix 2-1 Design Software Recommendations
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Exporting Adobe Illustrator SVG files :

If you are used to designing graphics in Adobe Illustrator and would like to export SVG files 
for use in Beam Studio, please refer to the following steps to export files to avoid incompat-
ibility or non-support issues when importing into Beam Studio :

3. When the "SVG Options" window 
pops up, click "More Options" in the 
lower left corner. 

2. Select "SVG (svg)" > Click "Save".

I. Make sure the strokes are center-aligned 
   before drawing :

Window - Stroke, set “Stroke” as “Align 
Stroke to Center”.

II. Save the file:
1. Click “File” > Click “Save As...”.
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4. Please follow the screen below to set the SVG Options > Click "OK" to finish saving the file.

III. Importing files into the software :

Import SVG files by dragging and dropping them into the Beam Studio window, or by 

clicking the "Picture"              button on the left side of the Beam Studio toolbar.

Appendix 2-1 Design Software Recommendations
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Exporting Inkscape SVG files :

If you are used to using Inkscape to design graphics and willing to export SVG files for use 
in Beam Studio, please refer to the following steps to export files to avoid incompatibility or 
unsupported problems when importing into Beam Studio :
I. Check the version of Inkscape : "Inkscape" > "About Inkscape", it should be version 1.0 or 
   above.

II. Set the document properties before sketching : "File" > "Document Properties", set the 
    Scale to 1.0 and the Units to mm.

III. Save the file : Click "File" > "Save As..." > Select "Plain SVG (*.svg)" > Check the box to  
     export as SVG 1.1 > "Save".
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IV. Importing files into the software : Drag and drop files into the Beam Studio window or 
click the "Image" button on the left side of the Beam Studio toolbar to import SVG files. 
If you import SVG 1.1, a reminder window will pop up, click "OK" to continue using the 
software.

Appendix 2-1 Design Software Recommendations
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Appendix 2-2 Design Inspiration

Inspirations :

Graphic Resources :

Wood Crafts & Paper Crafts :

Free Fonts :

Pinterest Idea Board : https://pse.is/JXRR5
Ponoko 150 Laser Engraving Ideas : https://pse.is/HQARL

The Noun Projects (free vector graphics) : https://thenounproject.com/
Freepik (free vector graphics) : http://freepik.com/

DXF Projects (wood crafts) : https://dxfprojects.com/
Canon Creative Park (paper crafts) : http://cp.c-ij.com/sc/index.html
Paper-replika (paper crafts) : http://paper-replika.com/

Font-Bear (Japanese and Chinese characters) : https://fontbear.net/
Dafont (English characters) : https://www.dafont.com/

Search for “laser engraving” on Pinterest.com for more ideas
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Appendix 3-1 Maintenance Checklist

To download the form, please go to “FLUX > Supports > Help Center” > Search : Mainte-
nance Checklist, download and print the checklist.

Even if the machine is used sparingly, necessary maintenance items should 
still be maintained on time to ensure the machine health. Leaving the machine 
unused for a long time may accelerate the aging, regular use and proper main-
tenance is the way to avoid the machine from being out of action.

Maintenance Checklist provides the key points to be checked by users at different times, 
please follow the instructions of 【Maintenance】(p.121) for maintenance procedures.
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* : Necessary maintenance
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Appendix 3-1 Maintenance Checklist
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